Master Guide

SAP NetWeaver 7.5
Document Version: 1.2 — 2017-06-01

‘f‘
N
v: :
N g
AN 5
W —— ||&‘
L] “
£
o _E v

PUBLIC

I —<




Content

11
1.2
1.3
1.4
15
16

21
2.2
2.3
2.4
25
2.6
2.7
2.8
2.9
2.10
211
212

31
3.2
3.3

3.4

Getting Started. . .. ... ... i i ey 5
Aboutthis Document. . . . .. 5
GlOSSarY. . . 5
SAP NetWeaver Use Cases. . . .. oottt 9
Business View of the Use Cases. . . . . . . .o 1
Mapping of Use Cases to Installable Software Units. . . ... ... .. ... ... . ... . .. . .. ... . . . ...... 12
Enhancement Packages. . . . . . .. .. . 15

Enhancement Package Concept. . . . . . . . .. . . 15

Key Facts About Enhancement Packages. . . . .. ... ... . . . . e 17
UpgradeataGlance. . .. ... ... ittt ittt et e eesasanaasasananaasasanannnsnns 18
The Overall Processata Glance. . . .. .. ... . . 18
Documentation Reading Sequence. . . . . ... .. 19
Upgrade Paths: Upgrade or EHP Installation. . ... ... .. .. 20
Upgrade ToOIS. . . ..o 21
Dual-Stack Split. . . . .. 24
Transition from SAP NetWeaver 2004. . . . . . .. 25
Transition from SAP NetWeaver 7.0. . . . . .. 27
Transition from SAP NetWeaver Pl 7.1, . . . .. 31
Transition from SAP NetWeaver Mobile 7.1. . . . . ... 32
Transition from SAP NetWeaver Composition Environment 7.1and7.2. . . ... ... ... .. .. ... .... 32
Transition from SAP NetWeaver 7.3 and SAP EHP 1 for NetWeaver 7.3. . . ... ... ... ... .. ... .. ... 34
Transition from SAP NetWeaver 7.4, . . . .. . 35
Planningand Preparation. . . ... ... ..ottt i it it m s m e 39
Major Planning Steps and Related Documentation. . . . ... ... .. . 39
Preparatory Activities. . . . . .. .. 40
Preparing SAP Solution Manager. . . . . . ... ... . 42

SAP Solution Manager Update. . . . . ... . ... . . . 42

Configuration of the Maintenance Optimizer. . . . .. ... . . 43

Maintaining System Landscape Information. . . . ... ... .. 44
System Copy and Migration. . . . ... 50
Upgrading, Configuration, and Follow-Up Activities. . . . ... ... ... i n 51
Upgrading Procedures for NetWeaver Key Areas. . . . .. ... . e 51

Upgrade of Scenarios Based on SAP Enterprise Portal. . ... .. .. ... ... ... .. .. .. .. ... . .... 51

Upgrade of Scenarios Based on SAP Business Warehouse. . . . ...... ... ... .. .. .. ........ 52

Upgrade of Scenarios Based on SAP Process Integration. . .. ........... ... ... ... .. ...... 57

SAP NetWeaver Upgrade Master Guide
PUBLIC Content



4.2

Al
A2
A3

A4

Upgrade of Scenarios Based on SAP Composition Environment. . . ... ........... ... ... ... 63
Upgrade of Scenarios Based on SAP NetWeaver Mobile. . .. .. ... .. .. ... . ... .. .. ... ...... 65
Upgrade of SAP Knowledge Warehouse. . . . ... ... ... .. . . . . . 68
Custom Application Development (ABAP). . . . . . 73
Configuration of Systems and Follow-Up Activities. . ... ... ... . . . . . 75
Y 0 o 1= T 77
Documentation References. . . . . . .. 77
Additional Information for Implementing SAP NetWeaver. . . ... ... ... ... . . . . . .. . .. .. 81
Description of Software Units. . . . . . ... e 83
Systems with Product Instances. . . ... ... .. .. 84
Optional Standalone Units. . . . .. . 94
Standalone Engines. . . . .. 96
Clients. « 98
Compatibility Product Instances. . . . .. ... 101

SAP NetWeaver Upgrade Master Guide

Content

PUBLIC 3



Document History

The following table provides an overview of the most important document changes.

Caution

Before you start the upgrade, make sure that you have the latest version of this document. You can find the

latest version on the Service Marketplace at http://service.sap.com/upgradenw?75% | Planning 3

Table 1:

Version Date Description

1.0 October 20, 2015 Initial Version

1.01 December 17, 2015 Update of chapter 4.1.3.2 (Upgrade of
System Landscapes Including ES Repo-
sitory for SAP CE [page 63])

11 February, 29, 2016 Corrected a paragraph about the SAP
NetWeaver Application Server for ABAP
in chapter Systems with Product Instan-
ces [page 84].

1.2 June 01, 2017 Added information about SAP Gateway
Foundation in chapter Standalone En-
gines [page 96].

Several link and graphic updates
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1 Getting Started

11 About this Document

This Upgrade Master Guide provides a central starting point for the technical upgrade to SAP NetWeaver 7.5. It
outlines the overall upgrade process, and refers you to the required detailed upgrade documentation, installation
documentation, and SAP Notes.

1 Note

The Upgrade Master Guide is regularly updated.. Make sure that you have the latest version by checking http://
help.sap.com/nw75 [+ Installation and Upgrade 3 immediately before starting the update or upgrade.

Constraints

The business scenarios that are presented here serve as examples of how you can use SAP software in your
company. The business scenarios are intended only as models and do not necessarily run the way they are
described here in your customer-specific system landscape. Check your requirements and systems to determine
whether these scenarios can be used productively at your site. Furthermore, we recommend that you test these
scenarios thoroughly in your test systems to ensure that they are complete and free of errors before going live.

See Also

The technical implementation of this SAP solution is described in the document Master Guide — SAP NetWeaver
7.5. The Master Guide is available at http://help.sap.com/nw75 | Installation and Upgrade 3.

1.2 Glossary

Short overview of some technical terms as well as SAP NetWeaver key terms:

1 Note
Usage Type, Technical Usage, and Product Instance

The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731
#ir . Note that there is no terminology change for older releases and all mentioned terms can be used as
synonyms.
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Table 2:

Term

Client

Explanation

Clients are additional installable programs or tools. They reside either on local front-end PCs
accessed by users or on back-end systems where they act as client programs within an SAP
NetWeaver system landscape.

Functional Unit

A configured and activated unit of SAP NetWeaver that provides a set of functions, allowing
the implementation and execution of activities such as process steps within IT scenarios. It is
nestable and can be grouped into larger functional units. Examples include transport manage-
ment system, system landscape directory, adapter framework, and business process engine.

Landscape Pattern

Defines if a technical system is used by one or several product systems to calculate update
and upgrade methods. The landscape pattern can be defined as “hub” system (if used by sev-
eral product systems) or as “sidecar” system (if used by one product system).

LMDB

Landscape Management Database

Central storage and editor for system information in SAP Solution Manager, supplied by a
central SLD. In the LMDB, you manage technical information (such as technical systems and
hosts) and logical information (such as product systems and technical scenarios). This data
is the basis for other applications, like monitoring and alerting, diagnostics, maintenance
transactions, and SAP Support Portal.

Logical Component

Group of technical systems that provide a concrete business function by installed product in-
stances and by different roles (such as development, test, or production system).

Maintenance Optimizer
(MOpz)

Application within SAP Solution Manager up to version 7.1 that guides you through planning
and downloading stack XML files for enhancement packages, support packages, and addi-
tional update packages. These files can be used as input files for the installation by update
tools like Software Update Manager.

The MOpz is replaced by the Maintenance Planner, which is mandatory for SAP systems
based on SAP NetWeaver 7.5 and higher.

Maintenance Planner

Tool on SAP Service Marketplace to visualize the existing system landscape, and to plan and
simulate updates, upgrades, and new installations.

Maintenance planner is a solution hosted by SAP and helps you plan and maintain systems in
your landscape. You can plan complex activities like installing a new system or updating exist-
ing systems. All changes can be scheduled to be deployed at a convenient time, to minimize
downtime. Maintenance planner is the successor of Maintenance Optimizer, Landscape Plan-
ner, and Product System Editor. It simplifies the maintenance process by consolidating criti-
cal tasks such as definition of product maintenance dependencies, implementing changes by
generating stack configuration, downloading archives, and so on, in one tool.
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Term

Product

Explanation

An SAP offering in the SAP price list that performs business tasks.

The complete product model is shipped as SAP Software Catalog. The availability of products
is published in the Product Availability Matrix (PAM). The product model defines the product
structure with its product instances, software components, version, and technical dependen-
cies between product and its components. Products typically have a name starting with
'SAP..." and are characterized by a version period and a maintenance cycle. A product can be
installed on one or more technical systems. All technical systems that are involved form the
product system.

Examples for products are SAP ERP, SAP NetWeaver, and SAP Solution Manager.

Product Instance

Part of a product version that bundles one or more software components.

A product instance is part of only one product version. It must be installed and updated as a
whole on a single technical system. Patches can still be installed for individual software com-
ponents. A product instance can contain other product instances. It can be re-used across
products.

Examples for product instances are SAP ECC Server and SAP NetWeaver AS ABAP.

Product System

A group of technical systems on which a product version is installed. Product system descrip-
tions are used to maintain and plan products in the system landscape.

Product Version

A release of an SAP product.

It bundles product instances and the included software component versions that are available
at a particular time for a specific scope of functionality. Like products, product versions are
shipped in the SAP Software Catalog. They are the basis for the compatibility of closely cou-
pled systems and the maintenance of product systems.

An example is SAP ERP 6.0, which is a product version of the product SAP ERP.

Optional Standalone Units

Optional standalone units are additional software units that you install separately. They are
based on Application Server Java (AS Java) and provide specific (server) functions in combi-
nation with one or more SAP systems.

SLD

System Landscape Directory

Central provider of information on technical systems, for consumers in the system landscape
and for external consumers. The SLD obtains its information mainly from SLD data suppliers,
which are installed on the technical systems, and from the SAP software catalog.

With the SLD, you collect and edit system data that is required for system landscape manage-
ment. This information can be used by other consumers, such as SAP Process Integration,
Web Dynpro for Java, and SAP Solution Manager.
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Term

Software Component

Explanation

Delivery and product unit of an SAP software product

A software component comprises a set of packages that are delivered in a single unit. You al-
ways assign repository objects to a software component by assigning the package containing
these objects. This makes it possible to move repository objects from one software compo-

nent to another during a release upgrade. A software component is released in successive re-
leases with new functions. You can import patches into each software component separately.

Software Provisioning Man-
ager

A tool that performs software provisioning processes such as installation, uninstallation, sys-
tem copy, or system transformation. The Software Provisioning Manager is delivered with the
Software Logistics Toolset.

Stack configuration file

The stack configuration file is created by the Maintenance Planner and is system-specific. De-
pending on the software components that are installed in a system, the Maintenance Planner
calculates the required software components that have to be updated to reach a certain tar-
get configuration.

Standalone Engine

Standalone engines of SAP NetWeaver are additional installable software units. They do not
work as full-blown systems of SAP NetWeaver, but as standalone engines that provide a spe-
cific (server) function in combination with one or more SAP NetWeaver systems. Standalone
engines are not part of a product instance. They do not run on AS ABAP or AS Java.

Technical System

Describes a part of a product's software that is installed on one or several physical or virtual
hosts.

A technical system is installed and administered as a whole. It is identified by a system ID
(SID) or extended SID, a host, and an installation number. There are different technical sys-
tem types, for example Application Server (AS) ABAP, AS Java, or TREX. Technical systems
are central elements when it comes to software component deployment and operational ac-
tivities, such as monitoring and alerting.

Update

Activities to maintain or enhance a system, such as installing enhancement packages, instal-
ling add-ons, or applying support package stacks or support packages.

Note: The tool for system maintenance tasks is the Software Update Manager (SUM). In the
SUM guide, the term "Update" is used as collective term for all the tasks that can be per-
formed using this tool (such as performing release upgrades, installing enhancement pack-
ages, or updating a system with Support Package Stacks).

Upgrade

The switch from an older software version to a new version. Typically, both the server compo-
nent of a system landscape and other components are upgraded. Several different technical
upgrade procedures are used to upgrade the server component, such as the Repository
Switch upgrade or the System Switch upgrade.
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Term Explanation

Usage Type Note: This term has been replaced by Product Instance. See note at the beginning.

An installed and correspondingly configured part of an SAP NetWeaver system that provides
key capabilities for a system landscape. It specifies the intended purpose of a system, and it is
the result of the configuration of the underlying installed software units and the configuration
of the underlying functional units. Examples include business intelligence, process integra-
tion, and SAP Enterprise Portal.

Use Case A definition of use from the end users' perspective for accomplishing a specific goal within a
system. Use cases represent the main capabilities of the system to fulfill specific require-
ments.

1.3 SAP NetWeaver Use Cases

Use

The use cases illustrate how you can use your SAP NetWeaver implementation. The main use cases of SAP
NetWeaver and their corresponding key areas of SAP NetWeaver are as follows:

Table 3:
Use Case Corresponding Key Area of SAP NetWeaver
Building Composite Applications SAP Composition Environment
Data Warehousing SAP Business Warehouse
Building Integration Scenarios SAP Process Integration

Integrating and Self Servicing Content with SAP Enterprise SAP Enterprise Portal

Portal
Mobilizing Business Processes SAP NetWeaver Mobile
Custom Application Development (ABAP) (All areas that allow ABAP development on the SAP NetWea-
ver Application Server ABAP)
Constraints

As of SAP enhancement package 1 for NetWeaver 7.3, SAP NetWeaver Mobile is only available as add-on to SAP
NetWeaver. For more information, see SAP Note 1645275 .

SAP NetWeaver Upgrade Master Guide
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More Information

You can obtain all information about the key areas with regard to SAP NetWeaver 7.5 in the SAP Help Portal and in
SAP Community Network (SCN):

e SAP Help Portal

SAP Help Portal bundles access to SAP product documentation and also related information, such as SAP
Notes, product availability information, as well as community content.
For SAP NetWeaver 7.5, you access the Help Portal using the address http://help.sap.com/nw75# .

1. Choose|lr Application Help » <key area> 1 for an introduction to and an overview of the application.

2. Choose |l Application Help » Function-Oriented View » <functional area> 3 for a component-based
reference of all functions and tasks that can be performed with the product.

SAP Community Network (SCN)
The SCN is organized into more than 300 “spaces”, which support small, self-contained communities. These
communities are typically focused around a topic, an SAP product, or an industry. Each space contains a
complete set of social networking tools including a discussion forum, a blogging area, and an area where you
can publish and collaborate on documents.
As a logged-on member, you can go to any space in the SCN landscape but it’s likely that you will be
interested in visiting and following a particular set of spaces that reflect your particular range of interests and
where members who share your interests are likely to hang out.

SCN spaces are where you get the latest news from SAP and the community, where you interact with your
peers, where you earn points for your contributions, and where you establish reputation as being expert on
certain topics
You access the SCN using the address http://scn.sap.com .

1. Tolearn more about SAP NetWeaver, choose:

o |k Products » tab “Technology” # Application Foundation/Integration » SAP NetWeaver 3 or
o |k Lines of Business § Information Technology # SAP NetWeaver 3

o http://scn.sap.com/community/netweaver

2. Moreover, SAP Community Network provides you with detailed information regarding the SAP
NetWeaver use cases:

Table 4:

For the use case

Integrating and Self Servicing Content with SAP Enterprise |> Products > tab “Technology” > Application Foundation/

choose in the SCN Community:

Portal ) o
Integration » SAP NetWeaver » Team Productivity » SAP
Enterprise Portal }
or choose http://scn.sap.com/community/enterprise-portal
L

Data Warehousing |} Products > tab “Technology” > Application Foundation/

Integration > SAP NetWeaver > Information Management >
SAP Business Warehouse 4

or choose http://scn.sap.com/community/data-warehous-
ing/bwite
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For the use case choose in the SCN Community:

Building Composite Applications | Products # tab “Technology” ¥ Application Foundation/
Integration > SAP NetWeaver > Process Orchestration >

Business Process Management }

or choose http://scn.sap.com/community/bpm#

Custom Application Development |» Products # tab “Technology” ¥ Application Foundation/
Integration > Custom Development > ABAP Development ]

or choose http://scn.sap.com/community/abap#

Mobilizing Business Processes |» Products # tab “Technology” ¥ Enterprise Mobility 4

or choose http://scn.sap.com/community/mobile

Building Integration Scenarios |\ Products # tab “Technology” ¥ Application Foundation/
Integration } SAP NetWeaver > Process Orchestration >
Process Integration & SOA Middleware ]

or choose http://scn.sap.com/community/pi-and-soa-mid-
dleware

1.4 Business View of the Use Cases

For implementation and configuration purposes, the SAP NetWeaver use cases are structured according to the
business view of SAP's Software Portfolio. This portfolio is structured using elements such as

e Solutions

e Solution Editions

e Key Capabilities / Scenario Groups

® Scenarios / Processes

Various tools, services, and processes, such as the Business Process Repository for the SAP Solution Manager,
use the business view of the SAP Software Portfolio.
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The following table displays the structured business view of the use cases in the SAP Solution Manager:

Table 5:

Use Case

Corresponds to Business Scenario

Group or Key Capability

Includes the Scenarios or Processes

Building Composite Applications

Building Composite Applications

Business Rules Management

Java Development and SOA Infra-
structure

Process Composition

Data Warehousing

Enterprise Data Warehousing

Data Modeling

Define Data Flow
Metadata Management
Performance Optimization

Scheduling and Monitoring

Building Integration Scenarios

Building Integration Scenarios

Building Integration Scenarios

Building integration-centric processes

Building integration-centric proc-
esses using the single-SID Pl and
BPM solution

Integrating and Self Servicing Content
with SAP Enterprise Portal

Integrating and Self Servicing Content
with SAP NetWeaver

Building Communities with Wikis &
Forums

Content Management Scenarios
with Knowledge Management
Managing and mashing up portal
pages with Web Page Composer
Portal Landscape Interoperability
and Openness

Unified Access to Applications and
Processes

Mobilizing Business Processes

Mobilizing Business Processes

Developing Mobile Applications for
Occasional Connection

Enabling Mobile Applications for Oc-
casional Connection*

Custom Application Development
(ABAP)

Custom Application Development
(ABAP)

Custom Application Development
(ABAP)

Application Lifecycle Management

Application Lifecycle Management

1.5 Mapping of Use Cases to Installable Software Units

To give you a quick overview of SAP NetWeaver 7.5, the table below shows the mapping between use cases of this
SAP NetWeaver version and required SAP NetWeaver software units. For details about the product instances, see

SAP NetWeaver Upgrade Master Guide
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section Description of Software Units [page 83]. For more information about the use cases, see the Master
Guide - SAP NetWeaver 7.5.

Table 6:

Use Case

Product Instance

Standalone Engines

Optional Standalone

Clients

Building Composite Ap-
plications:

Business Rules
Management and
Process Composition

e AS Java

e Adobe Document
Services (optional)

® Business Process
Management and
Business Rule
Management

e Composition Envi-
ronment Platform

e Dl [optional]

e SAP NetWeaver
Developer Studio

e Visual Composer

e Adobe LiveCycle
Designer (Op-
tional)

e Web Browser

Building Composite Ap-
plications:

Java Development and
SOA Infrastructure

e AS Java

e DI [optional]

e Enterprise Serv-
ices Repository

e SAP NetWeaver
Developer Studio

e Web Browser

Data Warehousing

e ASABAP
e BWABAP
e ASJava

e Bl Java [optional]
or, alternatively,
SAP BusinessOb-
jects Business In-
telligence platform
* [optional]

e [P Core — Applica-
tion Portal [op-
tional]

e [Enterprise Portal
[optional]

Search and Classifica-
tion (TREX)

e SAP GUI with Busi-
ness Explorer (Bl
add-on)

e Modeling Tools for
SAP BW, powered
by SAP HANA (BW
Modeling Tools)

e SAP BusinessOb-
jects Analysis, Edi-
tion for Microsoft
Office* [optional]

e SAP Crystal Re-
ports* [optional]

e SAP BusinessOb-
jects Dashboards
[optional]

e SAP BusinessOb-
jects Web Intelli-
gence* [optional]

e SAP BusinessOb-
jects Design Stu-
dio* [optional]
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Use Case

Product Instance

Standalone Engines

Optional Standalone
Units

Clients

Building Integration

e Application Server

e Adapter Engine

e Advanced Adapter

Scenarios Java (Java SE) [op- Engine [optional]
e Application Server tional] e Advanced Adapter
ABAP Engine Extended
® Process Integra-
tion
e Enterprise Serv-
ices Repository
® Process Integra-
tion Adapter En-
gine
Integrating and Self e ASJava
Servicing Content with | e EP Core — Applica-
SAP Enterprise Portal: tion Portal
e (P
e Portal Add-on (for
Building
Communities with
Wikis and Forums
only)
Mobilizing Business e ASABAP e SAPGUI
Processes: e Mobile e SAP NetWeaver
Developing Mobile ® Application Server Developer Studio
Applications for Java e Mobile Client
e DI

Occasional Connectivity

e EP Core - Applica-

f\nat;lmf MOt;”e tion Portal [op-
pplications for tional]

Occasional Connectivity

Custom Application e ASABAP e SAPGUI

Development e ABAP Develop-
ment Tools
(Eclipse)

SAP Knowledge Ware- | ® ASABAP e Searchand Classi- e \Web Browser

house e ASJava fication (TREX) e SAP GUI (KW Add-

e Content Server

on included)

*Note that SAP BusinessObjects products require separate licenses.
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1.6 Enhancement Packages

1.6.1 Enhancement Package Concept

We have adapted our major release strategy to better fit your adoption cycle. To ensure that you benefit from new
developments and innovations while minimizing the impact on your core operational systems, SAP uses
enhancement packages to speed up the delivery of new functions.

With SAP enhancement packages, you can install and activate new functions depending on your business needs
without having to perform a system upgrade.

You can selectively implement the new functions and activate the software upon business demand. As a result,
you can isolate the impact of software updates and make new functions available faster due to shortened test
cycles.

Implementation

There are three different scenarios to implement an enhancement package:

e |nstallation of an enhancement package on an existing SAP system
e New installation of an SAP system including an enhancement package
e Upgrade of an SAP system including an enhancement package

Maintenance

SAP enhancement packages have support packages of their own that are equivalent to the support package
versions of the underlying SAP system. We highly recommend installing the enhancement package in
combination with the latest available support package stack. This approach reduces installation, modification
adjustment, and testing effort. Using this strategy, you can install SAP enhancement packages as a normal
maintenance activity together with support package stacks.

An enhancement package requires a specific support package stack level in the source release SAP system.

1 Note

If the SAP system is on a lower support package stack level, all relevant support package stacks for the
enhancement package installation are automatically included into the download queue by the Maintenance
Planner, as well as the latest available support packages for the enhancement package.

For a better understanding of the general concepts and principles of updating a system, see the Maintenance
Planning Guide and the Planning Landscape Changes - A Best Practice Guide at http://wiki.scn.sap.com/wiki/x/

ViwqCw# |+ column “Guides” 3

SAP NetWeaver Upgrade Master Guide
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Tools

The enhancement package installation requires the following tools:

1. SAP Solution Manager

1 Note

Use of SAP Solution Manager is mandatory.

Tool versions:

We recommend that you always use the latest version of the SAP Solution Manager. For more information,
see SAP Support Portal at http://support.sap.com/solutionmanager #r .

System Landscape Maintenance with SAP Solution Manager:

Make sure that you have correctly defined and maintained your system landscape in SAP Solution Manager.
Use the Landscape Management Database (transaction LMDB) for the complete system description.

For more information about the Landscape Management Database (LMDB), see http://help.sap.com/

solutionmanager71#|» Application Help » SAP Library SAP Solution Manager 7.1 <SP version> » SAP
Solution Manager Operations » Landscape Management Database (LMDB) » Managing System Landscape

Information 3.

Landscape Verification with SAP Solution Manager:

To verify and correct your system landscape, SAP highly recommends that you use the verification functions
of the SAP Solution Manager. Use for this the landscape verification function that is embedded into the
product system editor of the Landscape Management Database (LMDB).

For more information about the landscape verification, see SAP Community Network athttp://scn.sap.com/
docs/DOC-8793# .

= Recommendation

Before installing the enhancement package, we recommend running a landscape verification to check your
landscape setup and your system descriptions, and to correct data if necessary.

2. Installation or upgrade tools (depending on your scenario)

o SAP Maintenance Planner
The maintenance planner is a hosted solution offered in SAP Support Portal, and lets you effectively plan
and maintain your landscape. It is the successor of Maintenance Optimizer, landscape planner, and the
product system editor in the LMDB. The maintenance planner consolidates critical tasks such as defining
product maintenance dependencies, generating stack configuration files, and selecting archives in a
single tool. The stack XML created by the maintenance planner can be consumed by Software Update
Manager (SUM) to update an existing system, or by software provisioning manager (SWPM) for new
installations.
For more information about the maintenance planner, see http://wiki.scn.sap.com/wiki/x/VIwqCw #r .

o Software Provisioning Manager 1.0
For the new installation of an SAP system including an enhancement package you use the standard
installation tool software provisioning manager 1.0. For more information about the tool, see https://
support.sap.com/sltoolset .

o Software Update Manager (SUM)
To install an enhancement package on an existing SAP system, as well as for the upgrade of an SAP
system to a higher release including an enhancement package, you use the Software Update Manager
(SUM).

SAP NetWeaver Upgrade Master Guide
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For more information bout the Software Provisioning Manager and the Software Update Manager see
https://support.sap.com/sltoolset .

1.6.2 Key Facts About Enhancement Packages

The following list summarizes important facts about the enhancement package concept and recommended
approaches:

You cannot mix the installation of different enhancement package versions in your ABAP-based SAP system.
You can have just one enhancement package version in the SAP system. This means, if you have already
updated product instances to a previous EHP you need to apply the current EHP to those components as well.

SAP enhancement packages are cumulative, meaning that each new enhancement package includes new
innovations of its own as well as all innovations delivered with prior packages.

We recommend installing the latest available enhancement package version.

Install enhancement packages and support packages in one single step (this includes the preconditioned
support packages).

SAP enhancement packages have support packages of their own that are equivalent to the support package
versions of the underlying SAP system.

SAP enhancement packages have the same maintenance period as the underlying core application.

The installation of an enhancement package is irreversible.

SAP NetWeaver Upgrade Master Guide
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2 Upgrade at a Glance

2.1 The Overall Process at a Glance
Use

The following graphic shows the main steps that are involved in the process and which are explained below:

Maintainance of Update SAP Solution Manager to latest SP Level

System Landscape v
Data
Register Systems in SLD and Transfer Data to Solution Manager
\ 4
Complete System Descriptionsin LMDB

\ 4
Run the Landscape Verification (in LMDB)

Selectionand Create Maintenance Transaction in Maintenance Tool
Download

of Files
Selectthe Software Packages

\ 4
\ 4
] i i .

Calculate Stack Configuration File {(stack.xml)

\ 4

Download Software Packages and Stack Configuration File

SAP System Planning and Preparation Activities
Upgrade v

Upgrade Procedure using Software Update Manager (SUM)

\4

. Follow-Up Activities

\ 4

Delta-Configuration of Systems

Figure 1: Overview of Main Steps of the Upgrade Process

1. You need the latest SAP Solution Manager system with the latest available Support Package stack level, and
the SAP Solution Manager Maintenance Optimizer needs to be configured if you use it..

2. You register your systems in the System Landscape Directory (SLD) and transfer the system data to SAP
Solution Manager.

3. You check and complete system data with transaction LMDB and update them, if necessary.

4. You run the landscape verification in SAP Solution Manager with transaction L.MDB to check if the system data
is sufficiently maintained to use the Maintenance Tool (Maintenance Optimizer or the Maintenance Planner).

SAP NetWeaver Upgrade Master Guide
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5. As soon as the system data is maintained correctly, you start a new maintenance transaction with the
Maintenance Optimizer or the Maintenance Planner.

6. As part of the maintenance transaction, you have to select the required software units you want to update as
well as the target Support Package level.

7. This selection is used by the Maintenance Optimizer or the Maintenance Planner to generate a stack
configuration file and to calculate the software components as well as the Support Packages.

8. You download the files using the Download Manager.

9. You plan and prepare the upgrade as described in SUM guide.

10. You upgrade the system using the Software Update Manager (SUM).

11. You carry out the follow-up activities as described in SUM guide and the SAP NetWeaver 7.5 update and
upgrade guides.

12. You check the configuration of your system and perform the configuration of the delta, if necessary.

More Information

e Regarding the SAP Solution Manager and the transaction LMDB as well as the landscape verification, see also
Enhancement Package Concept [page 15], section Tools.

e For abetter understanding of the general concepts and principles of updating a system, see the Maintenance
Planning Guide and the Planning Landscape Changes - A Best Practice Guide at http://wiki.scn.sap.com/
wiki/x/VIwgCwe | column “Guides" 3

e For information about finding other referenced guides, see section Documentation References [page 77].

2.2 Documentation Reading Sequence

In the different phases of your upgrade or enhancement package implementation project, different documents
and information sources support you with information. We recommend to read the documents in the following
order which leads you from overview documentation to detailed documentation

SAP NetWeaver Upgrade Master Guide
Upgrade at a Glance PUBLIC 19


http://help.sap.com/disclaimer?site=http://wiki.scn.sap.com/wiki/x/VIwqCw
http://help.sap.com/disclaimer?site=http://wiki.scn.sap.com/wiki/x/VIwqCw

Refers to Solution Manager Guides

Maintenance Planning Guide

Refi t
S Maintenance Optimizer Configuration Guide

= For systems based on SAP
NetWeawver
= DBIOS dependent

Refers to

iid

+ Application-specific
* Release-specific
+ DBIOS independent
+ Contain information about

Introduction

Upgrade SAP NW usage types
Master Guide Quick Guice {Checklist)
(OVEI"U'iEW Product-specific Planning &
i General Preparation
Information) Planning & Preparation Activities

Running the SUM

Product-specific
Follow-Up Activities

General
Follow-Up Activities

Troubleshooting and
Administration

Refers to SAP Notes / SAP Community NetWork (SCN)

Figure 2: Reading Sequence for Upgrade and EHP Installation

2.3 Upgrade Paths: Upgrade or EHP Installation

From a technical point of view, either an upgrade or an enhancement package installation will be carried out to
achieve the higher target SAP NetWeaver release, depending on the technology and the start release. To perform
both options, you use the Software Update Manager (SUM). For more information, see section Upgrade Tools

[page 21].

The following table provides an overview about the possible upgrade paths from earlier releases to SAP
NetWeaver 7.5:

Table 7:

Start Release Upgrade or Enhancement Package in- | Comment

stallation (EHP inst.)

e SAP NetWeaver 2004 (AS-ABAP No direct upgrade supported
6.40)
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Start Release Upgrade or Enhancement Package in- | Comment

stallation (EHP inst.)

e SAP NetWeaver 7.0 ABAP: Upgrade SAP NW 7.0 with Support Package 14 or
Oi i - high
e SAP NetWeaver 7.0 including En Java: Upgrade igher
hancement Package 1
® SAP NetWeaver 7.0 including En-
hancement Package 2

e SAP Composition Environment 7.1 | EHP inst.

e SAP Composition Environment 7.1
including Enhancement Package 1

e SAP Composition Environment 7.2

e SAP Process Integration 7.1 ABAP: Upgrade

e SAP Process Integration 7.1 includ- Java: EHP inst.

ing Enhancement Package 1

e AS ABAP 7.10 (Banking) Upgrade

e SAP NetWeaver 7.3 (with targetre- | ABAP: Upgrade

lease SAP NetWeaver 7.3 EHP1)
Java: EHP inst.

e SAP NetWeaver 7.4 ABAP: Upgrade

Java: EHP inst.

= Recommendation

Check also the PDF-document SUM SP <version> paths for a graphical representation of the supported update
and upgrade paths, that are possible with the Software Update Manager. This document is attached to every
central Software Update Manager note. You can find the latest central SUM Note at: http://support.sap.com/

sltoolsetP |l Software Logistics Toolset 1.0 » General Information » System Maintenance 3.

2.4 Upgrade Tools

SAP Solution Manager and SAP Maintenance Optimizer (MOPZ)

These tools for the upgrade to SAP NetWeaver 7.5 are described in this document in the Enhancement Package
Concept [page 15].

For further information about setting up and maintaining SAP Solution Manager for supporting the upgrade, see
Preparing SAP Solution Manager [page 42].
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Maintenance Planner

The Maintenance Planner is an autonomous tool that you can download from the SAP Service Marketplace. Itis a
solution hosted by SAP and helps you plan and maintain systems in your landscape. You can plan complex
activities like installing a new system or updating existing systems. All changes can be scheduled to be deployed
at a convenient time, to minimize downtime. Maintenance planner is the successor of Maintenance Optimizer,
Landscape Planner, and Product System Editor. It simplifies the maintenance process by consolidating critical
tasks such as definition of product maintenance dependencies, implementing changes by generating stack
configuration, downloading archives, and so on, in one tool.

Software Update Manager (SUM)

From a technical point of view, either an upgrade or an enhancement package installation will be carried out to
achieve the target release SAP NetWeaver 7.5, depending on the technology and the start release. For an
overview about the possible upgrade paths from earlier releases, see chapter Upgrade Paths: Upgrade or EHP
Installation [page 20].

To perform both options, you use the Software Update Manager (SUM). The Software Update Manager internally
calls the sapup tool for upgrade and enhancement package installation. SAP recommends that you download the
latest Support Package of the Software Update Manager as it contains latest corrections and is updated regularly.
The tool is delivered in regular intervals, independent from SAP application product shipments, via Software
Logistics Toolset (SL Toolset).

For more information about the SUM, see the SAP Service Marketplace at http://support.sap.com/sltoolset#r
| System Maintenance » System Update Manager (SUM) <version> 4.
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The following overview shows how the Maintenance Optimizer and the Software Update Manager work together:

SAP Service Marketplace
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Tool sum
Stack
.</ Configuration

File
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SAP Solution Manager 7.1 or higher
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Figure 3: How the Upgrade tools work together

Tools for Special Purposes

e Upgrade Dependency Analyzer
When you plan your upgrade, you can use the Upgrade Dependency Analyzer to check the existence of
upgrade dependencies between two separately installed SAP systems in your system landscape.
For more information, see SAP Service Marketplace at http://service.sap.com/uda .

e |nstallation of Additional Java Product Instances
If you want to install additional Java product instances in your upgraded system, you use the Software Update
Manager. For more information and installation instructions, see a SUM guide for Java that is relevant for your
database and operating system: Update Guide — Updating SAP Systems Using Software Update Manager (for
Java), section Installing Additional Product Instances in an Existing SAP System.

SAP NetWeaver Upgrade Master Guide
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2.5 Dual-Stack Split

Use

SAP NetWeaver 7.5 does not support any dual-stack systems, that is, an ABAP stack and a Java stack integrated
in one single system with a common system ID, a common startup framework, and a common database. (For
more information, see http://scn.sap.com/docs/DOC-33703# in SAP Community Network.)

This means that you have to split your optional dual-stack system (ABAP+Java system) before you perform an
upgrade or update to SAP NetWeaver 7.5 and higher. No upgrade or update of optional dual-stack SAP
NetWeaver systems to SAP NetWeaver 7.5 and higher is supported.

Caution

The only exception is SAP Process Integration (PI). If this is a dual-stack installation, you must perform the
update or upgrade to SAP PI 7.5 first and then the dual-stack split afterwards. See for more information
Upgrade of Scenarios Based on SAP Process Integration [page 57].

You split a dual-stack system into one ABAP stack and one Java stack each with its own system ID using the
software provisioning manager. This tool is part of the Software Logistics Toolset (SL Toolset) 1.0. Any dual-stack-
split functionality using the software provisioning manager will be offered in the SL Toolset, of which the offering
and the release schedule is documented in SAP Note 1563579 #r(Central Release Note for Software Logistics
Toolset 1.0).

The dual-stack-split is described in the Dual-Stack-Split guide that can be found on the Service Marketplace at

http://Service.sap.com/sltoolsetf | Software Logistics Toolset 1.0 » Documentation » System Provisioning
» Dual-Stack Split: Systems Based on SAP NW <version> .

The dual-stack split procedure is available only for SAP dual-stack systems based on the following release levels:

o SAP NetWeaver 7.0 SP14 or higher

® SAP NetWeaver 7.0 including Enhancement Package 1 or 2 or 3
e SAP NetWeaver 7.3

e SAP NetWeaver 7.3 including Enhancement Package 1

SAP Business Suite 7i2011, which is based on SAP NetWeaver 7.0 including Enhancement Package 3, is the last

SAP Business Suite release with dual-stack support. No upgrade or update of dual-stack SAP Business Suite
systems is supported to higher releases. For more information, see SAP Note 1816819 .

More Information

e For more information about the discontinuation of optional dual-stack deployments, see SAP Community
Network at: http://scn.sap.com/docs/DOC-33703 .

e For more information on the dual-stack split procedure offered by SAP, see SAP Community Network at:
http://scn.sap.com/docs/DOC-25162# .

e For information about the tool for the dual-stack split, refer to the Dual-Stack Split Guide on the SAP Service
Marketplace at http://Service.sap.com/sltoolset# | Software Logistics Toolset 1.0 » Documentation
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System Provisioning » Dual-Stack Split: Systems Based on SAP NW <Version> 3. This guide also informs
about the current SAP Notes regarding the dual-stack split. They contain the most recent information on the
dual-stack split, as well as corrections to the dual-stack split documentation.

e Forinformation about the use cases for splitting dual-stack systems, see SAP Note 1655335 .
e Forinformation about the dual stack support for Business Suite systems, see SAP Note 1816819# .

e For more information about the Software Logistics Toolset in general, see SAP Note 1563579# (Central
Release Note for Software Logistics Toolset 1.0).

2.6 Transition from SAP NetWeaver 2004

Caution

As the extended maintenance of SAP NetWeaver 2004 has been terminated in 2013, a direct upgrade from
SAP NetWeaver 2004 to SAP NetWeaver 7.5 is not possible anymore. The following describes the main
differences between the SAP NetWeaver release 2004 and 7.5 for your information only.

Relation Between Scenarios and Use Cases

SAP NetWeaver 7.5 no longer uses technical scenarios as defined with SAP NetWeaver 2004 to describe the
capabilities SAP NetWeaver provides. Instead, a set of “use cases” illustrates how you can implement and use
SAP NetWeaver. Use cases provide a structured access to configuration information in SAP Solution Manager and
therefore ease the implementation process.

From the following table you can see how SAP NetWeaver 2004 technical scenarios translate into SAP NetWeaver
7.5 use cases.

Table 8:

SAP NetWeaver 2004 - Technical Scenarios ’ SAP NetWeaver 7.5 - Use Cases

SAP Business Information Warehouse (SAP BW) Data Warehousing

Bl Information Broadcasting Data Warehousing

SAP Enterprise Portal (SAP EP) Integrating and Self Servicing Content with SAP Enterprise
Portal

SAP Mobile Infrastructure (SAP MI) Mobilizing Business Processes

SAP Knowledge Warehouse (SAP KW) No specific use case in SAP NetWeaver 7.5; Knowledge Ware-
house is an integral part of AS ABAP and AS Java
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SAP NetWeaver 2004 - Technical Scenarios

SAP NetWeaver Development Environment: Development of
ABAP applications

’ SAP NetWeaver 7.5 - Use Cases

The preferred SAP NetWeaver version for custom application
development in ABAP is SAP NetWeaver 7.4 as part of the
SAP Business Suite. Although AS ABAP is fully supported as a
development platform in SAP NetWeaver 7.5, the majority of
the installations is currently still using SAP NetWeaver 7.4 for
ABAP development.

SAP NetWeaver Development Environment: Development of
Java applications

Not described as a separate use case, part of the AS Java and
NWDI installation

SAP NetWeaver Development Environment: Team-oriented
development of Java applications

Not described as a separate use case, part of the AS Java and
NWDI installation

SAP NetWeaver Development Environment: Development
with SAP NetWeaver Java Development Infrastructure

Not described as a separate use case, part of the AS Java and
NWDI installation

SAP NetWeaver Development Environment: Interactive Forms
based on Adobe software

Custom Application Development ABAP (Web Dynpro Devel-
opment).

Note that the preferred SAP NetWeaver version for custom
application development in ABAP is SAP NetWeaver 7.4 as
part of the SAP Business Suite.

SAP NetWeaver Development Environment: Development of
Portal iViews Using SAP NetWeaver Visual Composer

Integrating and Self Servicing Content with SAP Enterprise
Portal

SAP NetWeaver Development Environment: Development of
Portal Content with PDK for .NET

Integrating and Self Servicing Content with SAP Enterprise
Portal

Installable Software Units

With SAP NetWeaver 7.0, usage types have been introduced. They replace the formerly known software
components, such as SAP Web AS ABAP. Usage types represent the capabilities of an SAP NetWeaver system
offered by a collection of installed and configured (technical) software components. A usage type defines the role

a system plays in a given scenario.

1 Note

Product Instance replaces Usage Type as of SAP NW 7.31

The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731
4. Note that there is no terminology change for older releases and all mentioned terms can be used as

synonyms.

When you upgrade your SAP NetWeaver 2004 components to an SAP NetWeaver release lower than 7.5, the
components are mapped to the corresponding product instances and upgraded accordingly. Missing software is
deployed so that your system contains complete product instances after the upgrade.
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In addition to SAP systems with product instances, there are additional SAP NetWeaver building blocks:
standalone engines and clients. See the Glossary [page 5] for a definition of these terms. For a description of
these software units, see Description of Software Units [page 83].

The following table provides an overview of the mapping between SAP NetWeaver 2004 components and the
software units of SAP NetWeaver 7.5.

Table 9:

SAP NetWeaver 2004 Components Building Blocks of SAP NetWeaver 7.5

SAP Web Application Server Components

SAP Web Application Server ABAP 6.40 Application Server ABAP (AS ABAP) [product instance]

SAP Web Application Server Java 6.40 Application Server Java (BASIC) [product instance]

Adobe Document Services Adobe Document Services [product instance]

SAP GUI SAP GUI [client]

SAP Internet Transaction Server (SAP ITS) Included in Application Server ABAP (AS ABAP) [product in-
stance]

SAP Gateway Gateway [standalone engine]

SAP NetWeaver Visual Composer Part of Composition Environment Platform (CE-ENV) [prod-

uct instance]

Forums Application Part of Portal add-on

Search and Classification Components

Search and Classification (TREX) Search and Classification (TREX) [standalone engine]

2.7 Transition from SAP NetWeaver 7.0

Caution

The upgrade to SAP NetWeaver 7.5 requires SAP NetWeaver 7.0 with Support Package 14 or higher.

Relation Between IT Scenarios and Use Cases

SAP NetWeaver 7.5 no longer uses IT scenarios as defined with SAP NetWeaver 7.0 to describe the capabilities
SAP NetWeaver provides. Instead, a set of use cases illustrate how you can implement and use SAP NetWeaver.
Use cases provide structured access to configuration information in SAP Solution Manager and therefore ease the
implementation process.
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From the following table you can see how SAP NetWeaver 7.0 IT scenarios translate into use cases for SAP

NetWeaver 7.5:

Table 10:

SAP NetWeaver 7.0 - IT Scenarios

SAP NetWeaver 7.5 - Use Cases

More Information

Running an Enterprise Portal

Integrating and Self Servicing Content
with SAP Enterprise Portal

Upgrade of Scenarios Based on SAP En-
terprise Portal [page 51]

Accelerating Global Delivery of Applica-
tion

Delivered as separate product — not
part of the SAP NetWeaver 7.5 shipment

For information about Accelerated Appli-
cation Delivery, see SAP Community
Network at http://scn.sap.com/
community/accad-for-netweaver P

Enterprise Knowledge Management:

Content Integration and Management;
Content Creation, Publication, and Ac-
cess

Integrating and Self Servicing Content
with SAP Enterprise Portal

Upgrade of Scenarios Based on SAP En-
terprise Portal [page 51]

Enterprise Knowledge Management:
Documentation, Training Materials and
Manuals Management

No specific use case in SAP NetWeaver
7.5; Knowledge Warehouse is an integral
part of AS ABAP and AS Java

Upgrade of SAP Knowledge Warehouse
[page 68]

Enterprise Search: Enabling Embedded
Search

No use case in SAP NetWeaver 7.5; Em-
bedded search is provided as part of AS
ABAP

Enabling User Collaboration

Integrating and Self Servicing Content
with SAP Enterprise Portal

Upgrade of Scenarios Based on SAP En-
terprise Portal [page 51]

Business Planning and Analytical Serv-
ices

Data Warehousing

Upgrade of Scenarios Based on SAP BW
[page 52]

Enterprise Reporting, Query, and Analy-
sis

Data Warehousing

Upgrade of Scenarios Based on SAP BW
[page 52]

Enterprise Data Warehousing

Data Warehousing

Upgrade of Scenarios Based on SAP BW
[page 52]

Enabling Application-to-Application
Processes

Building Integration Scenarios

Upgrade of Scenarios Based on SAP
Process Integration [page 57]

Enabling Business-to-Business Proc-
esses

Building Integration Scenarios

Upgrade of Scenarios Based on SAP
Process Integration [page 57]

Business Task Management

Building Composite Applications

Upgrade of Scenarios Based on SAP
Composition Environment [page 63]

Enabling Enterprise Services

Building Integration Scenarios

Upgrade of Scenarios Based on SAP
Process Integration [page 57]
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SAP NetWeaver 7.0 - IT Scenarios

SAP NetWeaver 7.5 - Use Cases

More Information

Developing, Configuring, and Adapting
Applications:
e Developing Java Applications using
Web Dynpro
e Creating Composite Applications

e Creating Applications Using SAP
NetWeaver Visual Composer

Building Composite Applications

Upgrade of Scenarios Based on SAP
Composition Environment [page 63]

Developing, Configuring, and Adapting

Applications:
e (Creating Business Applications Us-
ing ABAP
e Developing ABAP Applications Us-
ing Web Dynpro

The preferred SAP NetWeaver version
for custom application development in
ABAP is SAP NetWeaver 7.4 as part of
the SAP Business Suite. Although AS
ABAP is fully supported as a develop-
ment platform in SAP NetWeaver 7.5,
the majority of the installations is cur-
rently using SAP NetWeaver 7.4 for
ABAP development.

Developing, Configuring, and Adapting
Applications: Leveraging Java 2 Plat-
form, Enterprise Edition (J2EE) Stand-
ards for Porting and Adopting Applica-
tions

Not described as a separate use case in
SAP NetWeaver 7.5, part of AS Java and
Dl installation.

Developing, Configuring, and Adapting
Applications:

Developing Mobile Applications for Oc-
casional Connection

Mobilizing Business Processes

Upgrade of Scenarios Based on SAP
NetWeaver Mobile [page 65]

Developing, Configuring, and Adapting
Applications:

Integrating and Self Servicing Content
with SAP Enterprise Portal

Upgrade of Scenarios Based on SAP En-
terprise Portal [page 51]

SAP NetWeaver Operations

The Adaptive Computing Controller
which was part of the SAP NetWeaver
Operations IT scenarios, is delivered as a
separate product.

For more information about the Adaptive
Computing Controller, see SAP Com-
munity Network at http://scn.sap.com/
docs/DOC-8646

Software Life-Cycle Management

No separate use case described for SAP
NetWeaver 7.5; lifecycle management
capabilities of SAP NetWeaver are part
of every installation.

Mobilizing Business Processes

Mobilizing Business Processes.

Upgrade of Scenarios Based on SAP
NetWeaver Mobile [page 65]
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SAP NetWeaver 7.0 - IT Scenarios SAP NetWeaver 7.5 - Use Cases More Information
Authentication and Single Sign-On No separate use case defined in SAP
NetWeaver 7.5.

For information about authentication
and single sign-on, see SAP Help Portal
at http://help.sap.com/nw75"%

|} Application Help > Function-Oriented
View > Security > User Authentication
and Single Sign-On 4

Integrated User and Access Manage- No separate use case defined in SAP
ment NetWeaver 7.5.

For information about Integrated user
and access management, see SAP Li-
brary at http://help.sap.com/nw75 P

| Application Help # Function-Oriented
View > Security > Identity
Management ]

Changes in Usage Types

1 Note
Product Instance replaces Usage Type as of SAP NW 7.31

The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731
i . Note that there is no terminology change for older releases and all mentioned terms can be used as
synonyms.

Compared to SAP NetWeaver 7.0, some additional product instances are available with SAP NetWeaver 7.5. For
example, SAP NetWeaver Composition Environment has been integrated into the SAP NetWeaver platform.

When you upgrade your SAP NetWeaver 7.0 systems, the source release usage types are mapped to the
corresponding target release product instances. The following table shows which product instances will be in your
system after an upgrade to SAP 7.5 depending on the source release usage types.

Table 11:
SAP NetWeaver 7.0 - Usage Types ’ SAP NetWeaver 7.5 - Product Instances
Application Server Java e Application Server Java (BASIC)
o Adobe Document Services (ADOBE)
Process Integration ® Process Integration (PI)
e Advanced Adapter Engine (PI-AF)
e Enterprise Service Repository (ESR)
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SAP NetWeaver 7.0 - Usage Types ’ SAP NetWeaver 7.5 - Product Instances
Development Infrastructure e Development Infrastructure (DI)
Enterprise Portal e Enterprise Portal (EP)

e Composition Environment (COMP-ENV)

Enterprise Portal Core e [P Core — Application Portal (EPC)
e Guided Procedures (CE-PROCESS)

Bl Java e BlJava(BI)

2.8 Transition from SAP NetWeaver Pl 7.1

Use Case

The SOA-Based Integration use case has been renamed to Building Integration Scenarios.

Software Units

Compared to SAP NetWeaver 7.1, some additional product instances are available with SAP NetWeaver 7.5, for
example, SAP NetWeaver Composition Environment has been integrated into the SAP NetWeaver platform. The
following table shows which product instances will be in your system after the upgrade.

Table 12:
SAP NetWeaver Process Integration 7.1 SAP NetWeaver 7.5
Process Integration (PI) ® Process Integration (PI)
e Advanced Adapter Engine (PI-AF)
e FEnterprise Services Repository (ESR)
Application Server Java e Application Server Java (BASIC)
e Adobe Document Services (ADOBE)

For more information, see Upgrade of Scenarios Based on SAP Process Integration [page 57].

1 Note
Product Instance replaces Usage Type as of SAP NW 7.31

The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731
i . Note that there is no terminology change for older releases and all mentioned terms can be used as
synonyms.

SAP NetWeaver Upgrade Master Guide
Upgrade at a Glance PUBLIC 31


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1877731
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1877731

2.9 Transition from SAP NetWeaver Mobile 7.1

In comparison to SAP NetWeaver Mobile 7.1, SAP NetWeaver Mobile is available as an add-on technology solution
for SAP NetWeaver as of SAP enhancement package 1 for NetWeaver 7.3. You install SAP NetWeaver Mobile
separately on top of an Application Server ABAP system, and you perform the related configuration and set up
tasks after the installation.

The functional scope of SAP NetWeaver Mobile 7.1 and SAP NetWeaver Mobile 7.1 including enhancement
package 1is covered by the Mobilizing Business Processes use case of SAP NetWeaver 7.5.

For more information, see Upgrade of Scenarios Based on SAP NetWeaver Mobile [page 65].

2.10 Transition from SAP NetWeaver Composition
Environment 7.1 and 7.2

SAP NetWeaver Composition Environment has been integrated into the SAP NetWeaver platform. The functional
scope is covered by the use case Building Composite Applications including the capabilities Business Rules
Management, Process Composition, Java Development and SOA Infrastructure.

Compared to SAP NetWeaver Composition Environment 7.1 and 7.1 including enhancement package 1, SAP
NetWeaver 7.5 includes a different set of product instances. When you upgrade a system to SAP NetWeaver 7.5,
the source release usage types are mapped to the target release product instances and then the system is
upgraded accordingly.

SAP NetWeaver Composition Environment 7.2 and SAP NetWeaver 7.5 have the same usage type structure, so
there will be no changes when you upgrade your system except of the removal of the CE-Voice product instance.
For more information, see http://help.sap.com/nw75 [ Application Help » Function-Oriented View ¥
Composition Environment » Compatibility and Removed Usage Types 3.

1 Note
Product Instance replaces Usage Type as of SAP NW 7.31

The term “product instance” replaces the terms “usage type" and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731
. Note that there is no terminology change for older releases and all mentioned terms can be used as
synonyms.

The following tables show the mapping of usage types SAP NetWeaver Composition Environment 7.1and 7.1
including enhancement package 1, respectively to the product instances of SAP NetWeaver 7.5.

Source Release SAP NetWeaver Composition Environment 7.1
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Table 13:

SAP NetWeaver Composition Environment 7.1 SAP NetWeaver 7.5

Basic (BASIC) e Application Server Java (BASIC)
e Demo Applications (BASIC-RA)

Composite Applications (CE-APPS) Composition Environment

Composite Views (CE-VIEWS) Composition Environment Platform (COMP-ENV)

Composite Voice (CE-VOICE) Removed**

Composite Process (CE-PROCESS) Guided Procedures (CE-PROCESS)*

Adobe Print Services (CE-ADOBE) Adobe Document Services (ADOBE)

IDE Update Site (IDE-Update-Site) NWDS Update Site (IDE-Update-Site)*

Enterprise Service Repository (ESR) Enterprise Service Repository (ESR)

Source Release SAP NetWeaver Composition Environment 7.1 Including enhancement package 1
Table 14:

SAP NetWeaver Composition Environment 7.1 Including en- | SAP NetWeaver 7.5

hancement package 1

Application Server Java (BASIC) e Application Server Java (BASIC)
e Demo Applications (BASIC-RA)

Composite Applications (CE-APPS) Composition Environment

Composite Views (CE-VIEWS) Composition Environment Platform (COMP-ENV)

Composite Voice (CE-VOICE) Removed**

Guided Procedures (CE-PROCESS) Guided Procedures (CE-PROCESS)*

Adobe Document Services (CE-ADOBE) Adobe Document Services (ADOBE)

IDE Update Site (IDE-Update-Site) NWDS Update Site (IDE-Update-Site)*

Enterprise Service Repository (ESR) Enterprise Service Repository (ESR)

Business Process Management (BPEM) Business Process Management and Business Rules Manage-
ment (BPM)

BPM Portal Integration (BPEM-PP-Integration) Business Process Management and Business Rules Manage-
ment (BPM)

NW Development Infrastructure (NWDI) Development Infrastructure (DI)

* Note that Guided Procedures and NWDS Update Site are only provided for compatibility reasons. These product
instances are not included in a new installation of SAP NetWeaver 7.5. You can install them directly from SAP
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Service Marketplace on top of a new SAP NetWeaver 7.5 installation. Guided Procedures and NWDS Update Site
have been replaced by newer technologies.

For more information, see Upgrade of Scenarios Based on SAP NetWeaver Composition Environment [page 63]

** The Composite Voice (CE-VOICE) product instance is not available anymore from SAP NetWeaver 7.4
onwards. For more information, see http://help.sap.com/nw75| Application Help » Function-Oriented View »
Composition Environment » Compatibility and Removed Usage Types 3.

2.11 Transition from SAP NetWeaver 7.3 and SAP EHP 1 for
NetWeaver 7.3

Use

SAP NetWeaver 7.5 is a compatible successor release of SAP NetWeaver 7.3 and SAP enhancement package 1 for
NetWeaver 7.3. From a technical perspective, SAP NetWeaver 7.5 is positioned as an enhancement package and
follows all enhancement package rules with respect to compatibility and consumption.

SAP NetWeaver 7.5 is deployed as standalone on premise NetWeaver hub and serves in addition as foundation for
Business Suite (next EHP) and S/4HANA on premise.

Besides the optimization for SAP HANA, SAP NetWeaver 7.5 offers a wide range of additional capabilities
compared to NW 73/731. The following list emphasizes the highlights of the 7.5 release:

® |t comes with a fully integrated set of ABAP development tools for Eclipse to increase developer productivity,
and it offers an integrated development framework for the emerging HTML5 standard.

e The user interface has been harmonized with SAP NetWeaver Business Client 4.0 that offers a completely
new user experience based on tabbed browing, incremental search, and content adaptation exposed in the
contextual Side Panel.

e |tdelivers flexible modeling capabilities for BW on SAP HANA. It lowers TCO and dramatically increases

performance and flexibility of SAP HANA deployments with integrated lifecycle management capabilities.
e |t provides backend connectivity to consumers of the OData protocol with embedded Gateway capabilities.
e |tdelivers a new Portal experience with customized access to mobile users.

e |t facilitates unified Process Orchestration features running on a simple Java stack eliminating the need for
dual stack deployments. Integration scenarios can be monitored via SAP Solution Manager.

e |t fully enables single sign-on and identity federation.

More Information

For a complete list of all features and changes, see SAP NetWeaver 7.5 library at http://help.sap.com/nw75#
| What ‘s new — Release Notes.
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2.12 Transition from SAP NetWeaver 7.4

Use

SAP NetWeaver 7.5 a compatible successor release of SAP NetWeaver 7.4 From a technical perspective, SAP
NetWeaver 7.5 is positioned as an enhancement package and follows all enhancement package rules with respect
to compatibility and consumption.

SAP NetWeaver 7.5 is deployed on premise and serves as the foundation for upcoming releases of SAP Business
Suite software such as the next enhancement packages of SAP ERP. The release is designed to provide optimized
access to SAP HANA through enhanced capabilities such as Core Data Services (CDS).

In the following, you see a list of new and improved scenarios groups compared to SAP NetWeaver 7.4:
Integrating Fiori-based apps into SAP Portal 7.5

End-to-end uses cases:

e SAP Fiorilaunchpad (FLP) on Portal

e Personalization (SAP Fiorilaunchpad)

e (Content: Catalogs, FioriiView, Remote catalogs
e My Inbox

e Mobile Docs integration in FLP

Scenario description::

With SAP Enterprise Portal 7.5, you can now align and renew your Portal experience with the SAP Fiori UX
(launchpad and apps), while leveraging their existing investment in the Portal (iViews, roles, SSO).

SAP Enterprise Portal 7.5 and Fiori launchpad with Ul theme designer
End-to-end uses cases:

e Ajax Framework Page
e Fjorilaunchpad

Scenario description::

The new Fiori launchpad experience on the Portal (Fiori framework page) can now be branded with the Ul theme
designer.

New user experience with SAP NetWeaver Business Client (NWBC)
End-to-end uses cases:

e |ntegration of SAP Fiori apps in role menu (PFCG)

e No FLP configuration required when integrating in stand-alone mode
Scenario description::

Provides a bridge for customers moving non-disruptively from SAP GUI to Fiori-based user experience, by offering
one access point for all business content — SAP GUI, Web Dynpro, SAP Fiori apps.

Enables administrators to configure both familiar and new content in one, well-known role maintenance
environment (transaction PFCG).

Intelligent Business Operations
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End-to-end uses cases:

e |ntegration with SAP Operational Process Intelligence
® [ntegration with SAP PowerDesigner

Scenario description::
See next scenario group Fiori User Experience for Business Process Management (BPM).
Fiori User Experience for Business Process Management (BPM)

End-to-end uses cases:

e My inbox
e BPM OData Services
e BPM UI5 Generation

Scenario description::

SAP Process Orchestration is used by customers to automate and integrate business processes that span across
multiple applications in heterogeneous system landscapes.

However, today's organizations accumulate massive volumes of structured and unstructured data from business
applications, machines, social media and more. Enterprises are challenged to exploit the value of this information
within the context of end-to-end processes such as procure to pay, order to cash, idea to offering and plan to
inventory, among others. Many organizations struggle to have one single view of their processes and make use of
Big Data in a way that empowers line-of-business users to improve their operations.

Complementing SAP Process Orchestration with Operational Process Intelligence on SAP HANA allows
organizations to streamline their operations and embed Big Data insights into their processes in real time.
Process models and message flows can be easily imported into an end-to-end scenario, and linked with other
process fragments e.g. from SAP Business Suite or S/4HANA.

Line-of-business users will be empowered to gain full visibility into end-to-end operations to improve decision-
making and to take corrective actions when or even before issues occur.

SAP Process Orchestration and SAP Operational Process Intelligence can be deployed onto the same SAP HANA
instance, which reduced TCO and eliminates the need for data replication. In addition, organizations are also
looking to model and document their business processes in a process repository, and linking them to enterprise
architecture.

The integration of SAP Business Process Management with SAP PowerDesigner allows process developers to find
and import process models from a PowerDesigner repository, in order to make them executable. Technical
process models, which represent the implemented process, can be uploaded to the PowerDesigner repository for
process documentation, and linked to related resources such as organizations or systems.

Process Integration
End-to-end uses cases:

e New adapters for integration in hybrid landscapes
e (Cloud integration content for Process Orchestration
e B2BIntegration

Scenario description::

e New adapters for integration in hybrid on-premise/on-demand landscapes
e REST-, OData-, SuccessFactors-Adapter
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e (Cloud integration content for Process Orchestration

e Re-use of content across SAP HANA Cloud Integration and SAP Process Orchestration
e B2B Integration

e B2B add-on — one component addressing your EDI integration needs
® |[ntegration Advisor — Intelligent interface and mapping support

e Representational State Transfer (REST) adapter

e SuccessFactors adapter

e Connectivity add-on* for SAP Process Orchestration

e SuccessFactors adapter for flexible cloud deployment models

e B2Badd-on for SAP Process Orchestration

® One component for EDI based B2B communication

Custom Development (Java; ABAP)

End-to-end uses cases:

e Development of applications in ABAP-based CDS
e Adapt, redeploy, and rerun Java applications on Java 8

Scenario description::

® Development Scenario ABAP:
The data layer of SAP NetWeaver 7.5 is based on Core Data Services (CDS). CDS have already been
introduced in the predecessor release 7.4. In ABAP 7.5, they have been extended in many different ways
(annotations, extensions, built-in functions, table functions etc.) which allows you to develop modern ABAP
applications with a compelling user interface based on SAP UI5.
The ABAP developer tools help you to prototype the CDS layer quickly with many built-in templates and
wizards. The development scenario allows you to quickly implement state-of-the-art custom applications in
ABAP.

e Deployment Scenario Java:
SAP NetWeaver 7.5 is based on SAP JVM 8 that is based on JDKS.
JDK 8 comes with numerous improvements of the Java language. However, certain adaptations are required
to rebuild and redeploy your applications originally written for previous NetWeaver versions running on SAP
JVM6. The scenario helps you to rebuild and redeploy your application to SAP NetWeaver 7.5 Java.

SAP Business Warehouse (SAP BW)

End-to-end uses cases:

e Develop SAP BW Data Model
e Develop SAP BW Data Flows - within BW
e SAP BW Operations (Scheduling & Monitoring)

Scenario description::

The new release of SAP BW 7.5 powered by SAP HANA marks a consequent step forward in the evolution of BW
as SAP's strategic Enterprise Data Warehousing Solution in terms of:

e Platform Integration
One major aspect of SAP BW 7.5 is the continued adoption of the features SAP HANA offers as a platform
wherever it is beneficial for SAP BW customers.
With SAP BW 7.4, SAP HANA Smart Data Access and SAP HANA Dynamic Tiering were substantial first
services adopted from SAP HANA. Next will be SAP HANA Smart Data Integration capabilities available for
SAPBW 7.5.
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Simplification

SAP HANA also offers the possibility to simplify BW. By introducing the new CompositeProvider, the
Advanced DSO and the Open ODS View with SAP BW 7.4, data modeling has become easier and more flexible.
With SAP BW 7.5 numerous enhancements will make those InfoProviders the first choice when implementing
new scenarios. In addition the user experience has been further simplified and streamlined e.g. by introducing
Eclipse based modeling for data flows.

Big Data

Enhanced support for SAP HANA Dynamic Tiering and the extended Near-Line Storage (NLS) capabilities in
SAP BW 7.5 will help customers to further optimize RAM utilization and data persistence.

More Information

For more information about SAP Fiori UX, see http://scn.sap.com/docs/DOC-61694 # .
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3 Planning and Preparation

3.1

Major Planning Steps and Related Documentation

During an implementation project, you have to take into account many aspects and to take various decisions. The
major planning steps of this process are outlined below.

Caution

Unicode

SAP NetWeaver 7.5 supports Unicode only. A “Combined Upgrade & Unicode Conversion (CU&UC)" with
target SAP NetWeaver 7.5 is not possible. Make sure, that the SAP NetWeaver source system already supports

Unicode.

Table 15:

Step Description

Further Information

Scope and Requirements

You determine the scope of your SAP Net-
Weaver implementation.

For more information, see SAP NetWeaver
Use Cases [page 9].

Installable Software Units

You determine which installable software
units (that is, systems with product instan-
ces, standalone engines, optional stand-
alone units, and clients) are required for the
use cases.

For more information, see the Mapping of
Use Cases to Installable Software Units
[page 12] section.

Landscape Planning

You determine the system landscape and
consider the landscape-relevant aspects
concerning your required use case.

See Upgrading Procedures for NetWeaver
Key Areas [page 51].

Hardware & Software Prerequi-
sites

Use the Product Availability Matrix (PAM) to
check which platforms (operating systems,
databases, browsers) are supported for
your SAP NetWeaver components.

http://support.sap.com/pam

Check the recommended minimum data-
base versions.

See SAP Note 2158328 #r .

Check which hardware sizing is required for
your SAP NetWeaver release.

http://service.sap.com/sizing P

Release Restrictions

Check SAP Notes for any release restric-
tions.

Regarding SAP NetWeaver 7.5 release re-
strictions, see SAP Note 2206460#% .
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Step Description Further Information

SAP Solution Manager Prerequi- | We recommend always using the latest SAP | ®  See SAP Note 631042#% for informa-

sites Solution Manager release. tion about the Release strategy for Im-
plementation Content (ST-ICO).

e See SAP Note 781448 for informa-
tion about Support Package levels of

Make sure that your SAP Solution Manager
system has the required support package
level and content.
SAP Solution Manager installations and
Check if you need to do an update or up- upgrades.
e The Solution Operations Guide for SAP
Solution Manager is available at:http://
After an upgrade or update to the latest SAP service.sap.com/instguides® | SAP
Solution Manager release, you need to carry
out follow-up actions as described in the

section Software Change Management of

grade of your SAP Solution Manager appli-
cation or content.

Components # SAP Solution Manager
> <Release> > Operations 1

the Solution Operations Guide.

3.2 Preparatory Activities

From a technical point of view, either an upgrade or an enhancement package installation will be carried out to
achieve the target release SAP NetWeaver 7.5 depending on the technology and the start release

To perform both options, you use the Software Update Manager (SUM). General planning, preparation, and
follow-up activities as well as the handling of the Software Update Manager (SUM) are described in the SUM guide
Update Guide — Update of SAP Systems Using the Software Update Manager <version> available at http://

service.sap.com/maintenancenw75# or http://support.sap.com/sltoolset®r|p System Maintenance ¥
Software Update Manager (SUM) <version> # Guides for SUM <version> 3.

In addition, you have to perform preparations and follow-up activities specific to your product instance. These
specific actions are described in this guide in the following sections.

Caution

You have to perform both the general preparation activities as well as the product-instance-specific
preparations before you can start the Software Update Manager. Make sure that you start with these
preparations in good time. You can also consider performing these preparations in parallel to the preparation of
SAP Solution Manager and the download of the required software packages and the stack configuration file.

SAP Notes for Preparing the Update or Upgrade

To prepare and perform the update of your SAP system, you require some additional information in a range of
SAP Notes. You must read some of the notes, before you start with the preparations. Besides the central
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Software Update Manager note, there are separate SAP Notes for the database-specific sections. You must
request the following SAP Notes from SAP Support Portal before you start the update procedure:

e (Central Software Update Manager Note
e SAP Note for your database

During the upgrade, you may need information from some additional database-specific and database-
independent SAP Notes.

You find a list of these relevant SAP Notes in the following two guides, which you use in parallel considering your
specific combination of operating system, database and technology:

e SUM guide: Update Guide — Update of SAP Systems Using the Software Update Manager <version> available
on the SAP Service Marketplace at http://support.sap.com/sltoolset®|lp System Maintenance ¥ Software

Update Manager (SUM) <version> j Guides for SUM <version> 3
e (pgrade and Update Guide - SAP NetWeaver 7.5 available on the SAP Service Marketplace at http://

service.sap.com/upgradenw75# | Upgrade - SAP NetWeaver Systems 3

The following SAP Notes provide you with important information for your SAP NetWeaver implementation project.

Table 16: List of Important SAP NetWeaver Notes

SAP Note Number Title Description
2206460 Far Release Restrictions for SAP NetWeaver | Some restrictions apply to the produc-
7.5 tive use of SAP NetWeaver 7.5. These
are documented in this SAP Note.
21972590 M Add. info about the update/upgrade to | This SAP Note describes problems that
SAP NetWeaver 7.5 (incl. SPs and SRs) | may occur when you upgrade or update
your system and provides you with infor-
mation on how to solve them.
1 Note

Make sure that you have the up-to-date version of each SAP Note, which you can find on SAP Service
Marketplace at http://support.sap.com/notes# .

SAP Solution Manager Update

To prepare and perform the update of your SAP system, make sure that you use the latest available SAP Solution
Manager version. For an update to this SAP Solution Manager version, refer to the Master Guide — SAP Solution
Manager <release>. After you have performed the upgrade, follow the steps described in the SAP Solution
Manager <release> Configuration Guide.

Both guides are available on SAP Service Marketplace, at http://service.sap.com/instguides#|p SAP

Components » SAP Solution Manager Release <release> 1.
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3.3 Preparing SAP Solution Manager

To set up your SAP Solution Manager application, perform the following steps:

Maintain system data in the SAP System Landscape Directory (SLD)
Transfer system data from SLD to the SAP Solution Manager

Complete system descriptions in Landscape Management Database (LMDB)
Check the landscape data with the landscape verification function

O s wN e

Create a maintenance transaction in the SAP Solution Manager Maintenance Optimizer to calculate support
packages and packages for product instances

These steps are described in the Maintenance Planning Guide, which is available at http://wiki.scn.sap.com/
wiki/x/VIwqCw# (column Guides).

See the SAP Community Network (SCN) for more information about

e System Landscape Directory at http://scn.sap.com/docs/DOC-8042#ar
e Landscape Verification at http://scn.sap.com/docs/DOC-8793 ¢

SAP Solution Manager Maintenance Optimizer (MOPZ)

The SAP Solution Manager Maintenance Optimizer plays a central role in the upgrade process. It is mandatory to
use the Maintenance Optimizer for the calculation of the required upgrade packages, enhancement packages, and
Support Package stacks and for the creation of the stack configuration file (xml file). The upgrade program reads
this stack configuration file and uses it as an input file for the upgrade.

The following sections explain how to prepare SAP Solution Manager and the Maintenance Optimizer:

e SAP Solution Manager Update [page 42]
e Configuration of the Maintenance Optimizer [page 43]
e Maintaining System Landscape Information [page 44]

3.3.1 SAP Solution Manager Update

We recommend that you use the latest available Solution Manager version, or that you always update your SAP
Solution Manager to the latest Support Package stack.

Make sure that you run the guided procedure SOLMAN SETUP after every installation or update of SAP Solution
Manager and that it completes successfully.
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Table 17: Checking SAP Solution Manager Prerequisites

Step Description

1. Make sure that your SAP Solution Manager system has
the required support package level and content.

2. Check if you need to do an update or upgrade of your
SAP Solution Manager application or content.

3. After an upgrade or update to the latest SAP Solution
Manager release, you need to perform follow-up actions
described in the section Software Change Management of
the Solution Operations Guide

Documentation

e See SAP Note 608277 for information about SAP Sol-
ution Manager Content add-ons.

e See SAP Note 781448#% for information about Support
Package levels of SAP Solution Manager installations and
upgrades.

® The Solution Operations Guide for SAP Solution Manager
is available at:http://service.sap.com/instguidesfbl}
SAP Components > SAP Solution Manager >

<Release> > Operations 1

Table 18: Information about SAP Solution Manager Update or Upgrade

Related Documents

Available at...

Upgrade Guide SAP Solution Manager <Release>

Describes the update or upgrade to this release. You can in-
clude the installation of the required Support Package stack in
the update procedure.

http://service.sap.com/instguidesl'hr» SAP Components >
SAP Solution Manager » <Release> » Upgrade 3-

Solution Operations Guide — SAP Solution Manager <Release>
—> section Software Change Management.

Describes the actions required after the SAP Solution Man-
ager upgrade or update.

http://service.sap.com/instguides® | SAP Components
SAP Solution Manager > <Release> > Operations }

3.3.2 Configuration of the Maintenance Optimizer

If you have not already done so, configure the Maintenance Optimizer. For a list of configuration tasks, see the

Maintenance Optimizer configuration guide.

Table 19:

Related Documents

Available at...

Maintenance Optimizer Configuration Guide

http://wiki.scn.sap.com/wiki/x/VIwqCw e (column Guides)
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3.3.3 Maintaining System Landscape Information

Use

The Maintenance Optimizer relies on up-to-date information about your system landscape. Therefore, it is crucial
that this data is correctly maintained in the Landscape Management Database (LMDB). If you have already
maintained the system landscape data, check carefully if this data is correct.

Proceed in the following order:

1. If you have not already done so, capture the system data using the System Landscape Directory (SLD).
2. Maintain the system data in SAP Solution Manager.
3. Run the landscape verification to check the system landscape data.

Procedure

Capturing System Data Using SLD

1. Register all systems that you want to update in your SLD. In case of a dual-stack system, you have to register
both the ABAP stack and the Java stack.
Depending on your applications, it can either be the SLD of your SAP Solution Manager system (if there are no
dependencies of production runtime systems), or you have to separate SLD systems for production and non-
production use (default recommendation).
If you use a central runtime SLD, distribute the data of all technical systems that are registered in the central
SLD, from the central SLD to the development SLDs and to the local SLD in SAP Solution Manager.
For more information about the SLD topology options and synchronization, see the Planning Guide — System
Landscape Directory available at http://scn.sap.com/docs/DOC-804 2k
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To register Java systems, you use the Visual Administrator, or, as of SAP NetWeaver 7.1, the NetWeaver
Administrator. To register the ABAP system, you use transaction RZ70. For more information about the
registration of systems, see the SAP Library for your source release:

Table 20:

Release

1and SAP NetWeaver 7.0 including EHP 2

SAP NetWeaver 7.0 and SAP NetWeaver 7.0 including EHP

’ SAP Library Paths

http://help.sap.com/nw70&|} Application Help >
Function-Oriented View % SAP NetWeaver by Key
Capability > Solution Lifecycle Management by Key
Capability > Software Life Cycle Management > System
Landscape Directory > Configuring Systems to Connect to

stb 3

i Note

Instead of the alias /nw70, you can use the aliases /

nw701 or /nw702 accordingly.

o SAP NetWeaver 7.3, SAP enhancement package 1 for
NetWeaver 7.3

o  SAP NetWeaver 7.4
o  SAP NetWeaver 7.5

http://help.sap.com/nw73&|} Application Help >
Function-Oriented View # Solution Lifecycle Management
> Configuring, Working with and Administering System
Landscape Directory > System Landscape Directory >
Connecting Systems to the SLD ]

1 Note

Instead of the alias /nw73, you can use the aliases /
nw731, /nw74,or /nw75accordingly.

SAP NetWeaver Process Integration 7.1 including EHP1

http://help.sap.com/nwpi7ll?‘hr|} Application Help >
Function-Oriented View > Application Server Infrastructure
> Configuring, Working with and Administering System
Landscape Directory > Configuring Systems to Connect to

the SLD J

SAP NetWeaver Process Integration 7.1

http://help.sap.com/nwpi7ll‘h-|} System Administration
and Maintenance Information # Technical Operations for
SAP NetWeaver > General Administration Tasks >
Software Life-Cycle Management > Configuring, Working
with and Administering System Landscape Directory >

Configuring Systems to Connect to the SLD }
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Release

SAP NetWeaver Composition Environment 7.1 and SAP
NetWeaver Composition Environment 7.1 EHP1

’ SAP Library Paths

Connecting the system to the SLD is part of the initial sys-
tem configuration as described at:
http://help.sap.com/nwce71#|p Application Help
Administrator's Guide > Configuration of SAP NetWeaver
CE ¥ Initial System Configuration #» Configuring System
Landscape Directory }

1 Note

Instead of the alias /nwce71, you can use the alias /

nwce711 accordingly.

SAP NetWeaver Composition Environment 7.2

Connecting the system to the SLD is part of the initial sys-
tem configuration as described at:

http://help.sap.com/nwce72l‘hr|} Application Help >

Administrator's Guide > Configuration of SAP NetWeaver
CE > Configuring Mandatory Components > Configuring
Application Server Java » Mandatory Configuration Tasks

> Configuring System Landscape Directory ]

If the registration was successful, both the ABAP system and the Java system appear in the SLD under

Technical Systems.

2. Transfer the data from the SLD to the SAP Solution Manager: Set up the SLD connection under [+ SAP
Solution Manager Configuration (transaction SOLMAN_SETUP) » System Preparation » Prepare Landscape

Description ¥ Select SLD and Set Up LMDB 3.

For more information, see the SAP Solution Manager Library at http://help.sap.com/solutionmanager71#

| Application Help » SAP Solution Manager 7.1 SP<version> ¥ SAP Solution Manager Operations

Landscape Management Database (LMDB): » Managing System Landscape Information » Set Up the

Landscape Management Infrastructure » Connect LMDB to System Landscape Directory (SLD) 3.
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Figure 4: Synchronization of central SLD with local SLD in SAP Solution Manager
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Figure 5: Direct synchronization of central SLD with landscape data storage in SAP Solution Manager (standard as of SAP
Solution Manager 7.1)

1 Note
For more information about the synchronization of central SLD, see

e SLD Planning Guide at http://scn.sap.com/docs/DOC-14151#

e |nformation in the SAP Solution Manager Library at http://help.sap.com/solutionmanager71#

|+ Application Help » SAP Library SAP Solution Manager 7.1 SPO5 (or higher) » SAP Solution Manager
Operations » Landscape Management Database (LMDB): » Managing System Landscape Information 3.

Running the Landscape Verification

As of SAP Solution Manager 7.1 SPO5, the landscape verification function is integrated in the product system
editor of the Landscape Management Database (LMDB). To start the landscape verification, start transaction
LMDB, select a product system in edit mode and choose the Verification step in the navigation tree.

For more information, see the SAP Solution Manager Library at http://help.sap.com/solutionmanager71#
| Application Help  SAP Library SAP Solution Manager 7.1 SPO5 (or higher) ¥ SAP Solution Manager Operations
» Landscape Management Database (LMDB): » Managing System Landscape Information » Manage Logical

Landscape Information » Execute Verification Checks 3.
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Figure 6: Landscape verification in the product system editor of the LMDB

Maintaining System Data

When your product systems are known in SAP Solution Manager, you have to check and maintain the system
data, and add your system to a logical component and to a solution.

To manage logical components with SAP Solution Manager, proceed as follows:

1. Tocreate and edit logical components, choose | SAP Solution Manager: Work Centers » Solution Manager
Administration » Landscape » Logical Components 3.

2. Assign the related technical systems and the appropriate roles (such as Development System or Production
System) to the logical component. You have the following options:

1. Under |» SAP Solution Manager Configuration » Managed Systems Configuration 3, you have to assign
logical components to the technical systems registered in the LMDB. Select a technical system and
choose Configure System. Log messages tell you whether information is missing or inconsistent. These
checks prepare a technical system so that it can be used for Early Watch Alerts, for example.

2. You can also start transaction LMDB and select a technical system from the Technical Systems tab. In the
navigation tree, choose Software and Assign to Logical Component. For more information, see the
documentation on the Ul

For more information, see the SAP Solution Manager Library http://help.sap.com/solutionmanager71#
|\ Application Help » SAP Library SAP Solution Manager 7.1 SPO9 (or higher) % SAP Solution Manager Operations
» Landscape Management Database (LMDB) » Managing System Landscape Information » Managing Logical

Components 1.
To maintain system information with SAP Solution Manager, proceed as follows:

1. Intransaction LMDB, choose | Product Systems » <System> » Edit J.

2. Inthe navigation tree, choose Technical Systems to see which product instances of which product version of
which technical systems are assigned to the product system.
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3. Check, if the product version is correct.
4. To change the assignments, choose Add or Edit Selected.

5. We recommended that you start a verification run each time when you have changed an assignment. You can
perform this in the Verification step of the navigation tree.

For more information, see the SAP Solution Manager Library at http://help.sap.com/solutionmanager71#
| Application Help » SAP Library SAP Solution Manager 7.1 SPO5 » SAP Solution Manager Operations
Landscape Management Database (LMDB) » Managing System Landscape Information » Manage Logical

Landscape Information # Create Product System Information .

3.4 System Copy and Migration

Use

At several stages in the lifecycle of your SAP solution, you will face the requirement to perform a system copy or a
migration. For example, SAP recommends that you perform a system copy to create test, demo and training
systems. Also, if you need to change your operating system and/or database, you have to perform a migration of
your SAP system.

For this, SAP is offering system copy and migration services that enable you to create consistent copies of your
SAP systems, flexibly adapted to your needs - be it an SAP system distributed to several hosts, a high-availability
system or a system on a rather exotic operating system/database combination.

More Information

e Foranintroduction into system copy and migration, see http://scn.sap.com/docs/DOC-8324# in the SAP
Community Network.

e System copy guides are available on SAP Service Marketplace at http://service.sap.com/installnw75# .

e Alternatively, you can copy your system with a completely automated end-to-end framework available with
the SAP NetWeaver Landscape Virtualization Management <Release>, Enterprise Edition. For more
information, see the SAP Help Portal at http://help.sap.com/nwivm# .
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4 Upgrading, Configuration, and Follow-Up
Activities

4.1 Upgrading Procedures for NetWeaver Key Areas

In the following you find an overview about the procedures with regard to the different key areas of SAP
NetWeaver. For more information about the key areas, refer to SAP NetWeaver Use Cases [page 9].

4.1.1 Upgrade of Scenarios Based on SAP Enterprise Portal

Below you will find information about upgrading scenarios that are based on SAP Enterprise Portal. This section is
relevant for you if you used one of the following scenarios:

® SAP NetWeaver 7.0:
© Running an Enterprise Portal

o Enterprise Knowledge Management: Content Integration and Management; Content Creation,
Publication, and Access

o Enabling User Collaboration

As of SAP NetWeaver 7.3, the functional scope is covered by use case Integrating and Self-Servicing Content with
SAP Enterprise Portal. The following figure shows the software units which make up the use case.

Clients

Web Browser

Systems with Product Instances Standalone Engines

Web Dispatcher
Search and Classification (TREX)

Figure 7: Integrating and Self-Servicing Content with SAP Enterprise Portal
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4111 Upgrade Sequence

The following table describes the sequence in which you have to perform the upgrade or installation steps.

1 Note

For information about finding the referenced documentation, see section Documentation References [page
77].

Table 21:

Action Remarks / Subsequent Steps

[Required Documentation]

1 You upgrade SAP NetWeaver 7.0 Enterprise Portal. We recommend that you always install the latest avail-

ble SAP NetWeaver 7.5 t package stack.
[Update Guide — Update of SAP Systems Using Soft- | >© etiveaver /.o support package stac

ware Update Manager <version>]

[Upgrade and Update Guide - SAP NetWeaver 7.5
JAVA]

3 If installed as a separate system: you upgrade the sys-
tem with product instances AS Java and DI.

[Update Guide — Update of SAP Systems Using Soft-
ware Update Manager <version>]

[Upgrade and Update Guide - SAP NetWeaver 7.5
JAVA]

5 You upgrade the Forums Application.

[SAP Note 1049553 ]

6 You upgrade SAP NetWeaver Search and Classification
(TREX).

[Upgrade Guide — TREX 6.1 to SAP NetWeaver 7.0 TREX
(TREX 7.0)

[Upgrade Guide — TREX 7.0 to SAP NetWeaver 7.1 TREX
(TREX 7.1)]

7 Perform the delta configuration [page 75].

4.1.2 Upgrade of Scenarios Based on SAP Business Warehouse

Below you will find information about upgrading scenarios that are based on SAP Business Warehouse. This
section is relevant for you, if you use the following scenario:

o SAP NetWeaver 7.0x: Business Planning and Analytical Services; Enterprise Reporting, Query, and Analysis;
Enterprise Data Warehousing
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As of SAP NetWeaver 7.3, the functional scope is covered by the use case Data Warehousing. The following figure

shows the software units that make up the use case.

Clients

SAP GUI
incl.

ELy Business Web Design

Modeling

Crystal
Reports

Analysis

Explorer Browser Studio
(Bl Add-
On)

Tools

1 1 1
Systems with Product Instances Standalone
Engines
Bl Java

(TREX) Platform

AS ABAP

Figure 8: Data Warehousing

AS Java

1 Note
SAP Strategic Enterprise Management

If you have the SEM-BW add-on installed in your source release, read the following information in the SAP
Community Network:

1. http://scn.sap.com/docs/DOC-30452 ¢

2. http://scn.sap.com/community/data-warehousing/bw/blog/2013/11/13/good-news--easier-modeling-

of-the-sem-add-on-in-solution-manager #

4121 Data Warehousing on top of SAP HANA database

With SAP BW, powered by SAP HANA database, SAP offers the SAP HANA database being the in-memory
deployment option for the Data Warehousing use case. In combination with SAP BW 7.5 SPS O (or higher), it is
necessary to use SAP HANA SPS 10 or a higher revision. We recommend using the Revision as of
Datacenter Service Point asdescribedin SAP Note 2165826#% or a higher revision.

For more information on implementation considerations and implementation sequence, see the End-to-End
Implementation Roadmap for SAP BW, powered by SAP HANA on http://service.sap.com/installnw75

|» Planning 3, and see SAP Note 1600929#% as well as SAP Note 2203650#% .
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4122 Upgrade Sequence

Use

The following table describes the sequence in which you have to perform the upgrade or installation steps.

1 Note

e Forinformation about finding the referenced documentation, see section List of Documentation. [page
77] Consider also the composite notes for BW 7.30 Upgrade: 1636053 (Upgrade SAP NetWeaver 7.30:
BW-Server) and 1636057 (Upgrade SAP NetWeaver 7.30: Bl Java).

e Foranoverview about the steps needed for migrating an existing SAP BW installation to the SAP HANA
database, refer to the End-to-End Implementation Roadmap for SAP BW, powered by SAP HANA available

at http://service.sap.com/installnw75#|p Planning 3.

Procedure

Table 22:

Action Remarks and Subsequent Steps

[Corresponding Documentation] [Corresponding Documentation]

SAP BW on the SAP HANA database: .
Caution

® |ncase you want to deploy SAP BW on SAP
HANA database, and you have ABAP+Java dual
stack systems in your source release: Separate
the ABAP stack from the Java stack.
For more information, see section Dual-Stack
Split [page 24].

e See SAP Note 1600929#% for more informa-
tion.
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Action

[Corresponding Documentation]

You upgrade the SAP BW ABAP server.

[Upgrade and Update Guide - SAP NetWeaver 7.5
ABAP]

SAP Note 1943931/

Remarks and Subsequent Steps

[Corresponding Documentation]

e With NW 7.50 PI_BASIS including all its compo-
nents is part of Software Component SAP_BW.
This includes the SAP Enterprise Portal plug-in.

e Update the BI_CONT add-on to BI_CONT 757 dur-
ing the upgrade of the SAP BW server. The up-
grade process prompts you for the required DVD
at the appropriate point in time.

For more information, see SAP Notes 1985663 #r .
This version of Bl Content add-on will be used for
providing additional data flows.

If you use the already existing Bl Content Add-on
7.57 (SPO5 and higher) there is nothing much to
do. But we recommend upgrading to the latest
available support package of this Bl Content Add-
on7.57.

e Check also the SAP Note 153967 regarding the
Bl Content Release Strategy, and SAP Note
1000822#% for an overview about the notes for
the add-ons BI_CONT and BI_CONT_XT.

You upgrade your Java systems.

[Upgrade and Update Guide - SAP NetWeaver 7.5
JAVA]

If no AS Java based installation exists, but you want to
use Bl Java based functions, install an SAP NetWeaver
7.5 system with product instance Bl Java.

[Installation Guide — SAP NetWeaver Application
Server Java)

e Theinstallation of product instance Bl Java in-
cludes the installation of product instance EP
Core— Application Portal and EP, since Bl Java de-
pends on these product instances.
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Action

[Corresponding Documentation]

Remarks and Subsequent Steps

[Corresponding Documentation]

3 Optional: You upgrade SAP NetWeaver Search and TREX enables fast and complex search for Bl meta-
Classification (TREX). data. The metadata is directly indexed with its attrib-
[[Upgrade from TREX 6.1 to SAP NetWeaver TREX 7.0] utes .and itis available in .the search. Therefore, search

queries such as "All queries that contain the character-
[Upgrade Guide — SAP NetWeaver TREX 7.0 to TREX | istic 'customer' and the key figure 'sales' " are sup-
7.1]. ported. To be able to use all functions of the search (for
example, the search query described above), you have
to use TREX. However, as a base function, you can
search for objects using their text and technical name
also without TREX. For more information, see SAP
Note 979444 ¥ .
1 Note
If you use the SAP HANA database to persist data
from your SAP BW system, you can use the BW
search in the SAP HANA database. For the most im-
portant TLOGO objects, this allows you to perform a
search in the metadata of the objects and a search
for connections between these objects in the
where-used list.

5 Optional: You upgrade the SAP R/3 back end plug-in

to at least version 2004.1.
Documentation: Composite SAP Note 704564 %% : R/3
plug-in: PI 2004.1 installation/delta upgrade
1 Note
e New and extended interfaces for integrating
SAP R/3, SAP R/3 Enterprise, and SAP ERP
Central Component (SAP ECC) will no longer
be delivered with their own add-on (SAP R/3
Plug-In). As of SAP ECC 6.0, they will be con-
tained directly in SAP ECC. Therefore, this step
is not required for SAP ECC 6.0 or higher.
For more information about the delivery strat-
egy, see SAP Service Marketplace at https://
service.sap.com/r3-plug-infr.
e With Bl-Java, you have access to non-SAP data
sources by using the corresponding JDBC
driver.
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Action

[Corresponding Documentation]

You upgrade the SAP GUI for Windows including the Bl
add-on (Business Explorer) on each host for which you
want to create a connection to the SAP NetWeaver 7.5
BW server.

Remarks and Subsequent Steps

[Corresponding Documentation]

Up to SAP enhancement package 2 for SAP NetWeaver
7.0 you could maintain query properties using transac-
tion RSRT. As of SAP NetWeaver 7.3, the maintenance

of query properties has been partially moved into the

BE Desi . The settings Data Integrity and
[Installation Guide — SAP Front End] x Query Designer. The settings Data Integrity an
Read Near-Line Storage As Well are now available in

BEx Query Designer (in the Query Properties) and you

can no longer maintain them in RSRT.

As of SAP NetWeaver 7.5 and SAP BW Modeling tools
1.11, you can also maintain these properties in the
Query maintenance of the SAP BW Modeling tools.

7 You install the Modeling Tools for SAP BW powered by | See the installation guide at: http://service.sap.com/
SAP HANA to use the Eclipse-based BW modeling en- | \tinw 758 |l installation ¥ Installation - Clients 3.
vironment.

8 Perform the delta configuration [page 75].

4.1.3 Upgrade of Scenarios Based on SAP Process Integration

Caution

SAP NetWeaver 7.5 does not support any dual-stack systems, that is, systems based on an ABAP stack and a
Java stack and integrated in a single system with common system ID, common startup framework, and
common database. Such dual-stack implementations can still exist in former is SAP Process Integration
installations.

If you are still using such an older dual-stack implementation of SAP Process Integration (SAP PI)I, you must
perform the update or upgrade to SAP PI 7.5 first and then the dual-stack split afterwards.

1 Note

You can migrate SAP Pl content into SAP NetWeaver Pl Java single stack (Advanced Adapter Engine Extended).
This approach should be feasible for most use cases.

Due to the harmonized process orchestration stack (SAP Pl and SAP BPM running on the same Java instance),
stateful system-centric processes can be developed using SAP Process Orchestration capabilities. Processes
that are created with ccBPM need to be redesigned and modeled with SAP BPM. For more information about
how to do this, see the SAP Community Network SCN at http://scn.sap.com/docs/DOC-28803 s .

Below you will find information about upgrading scenarios that are based on SAP Process Integration. This section
is relevant for you if you use one of the following scenarios:

o SAP NetWeaver 7.0: Enabling Application-to-Application Processes; Enabling Business-to-Business
Processes, Enabling Enterprise Services
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e SAP NetWeaver Process Integration 7.1/ 7.1 including enhancement package 1: SOA-Based Integration
Note that the use case SOA-Based Integration has been renamed as Building Integration Scenarios.

As of SAP NetWeaver 7.3, the functional scope is covered by the use case Building Integration Scenarios. The
following figures depict the three options with the software units, which make up the use:

e SAP Pl dual usage type installations

1 Note

As of SAP NetWeaver 7.5, dual-stack installations of SAP Process Integration are replaced by dual usage
type installations that install the SAP NetWeaver AS for ABAP (Pl ABAP) and the SAP NetWeaver AS for
Java (Pl Java) on separate system IDs.

e Advanced Adapter Engine Extended (AEX) installation
® Process Orchestration

Business Process
Engine

Advanced Adapter
Engine (Non-
Central)

Adapter Engine - Integration
{Java SE)

II Business

System

Figure 9: System Landscape for Building Integration Scenarios with Pl Standard Installation

The dual usage type installation offers the complete functional range, whereas the functional range of AEX is
restricted, but has the advantage of a lower TCO.
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Figure 10: System Landscape for Building Integration Scenarios with Advanced Adapter Engine Extended

Process Orchestration provides a tool infrastructure to model and design business processes — from the overall
process flow and the sequence of activities up to the interfaces and data types that are needed to integrate SAP
systems and external systems. It combines the integration capabilities of SAP Pl Advanced Adapter Engine
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Extended (AEX) with the process modeling, operation, and monitoring capabilities of SAP Business Process
Management (BPM). Like AEX, Process Orchestration is based on AS Java only.
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Figure 11: System Landscape for Building Integration Scenarios with Process Orchestration

4131 Upgrade Sequence

The following table describes the sequence in which you have to perform the upgrade or installation steps.

1 Note

For information about finding the referenced documentation, see section List of Documentation.
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Table 23:

Action

[Required Documentation]

Remarks /7 Subsequent Steps

1 You upgrade the SAP NetWeaver system with product e \Werecommend that you always install the latest
instance Process Integration (Pl). available SAP NetWeaver 7.5 support package
stack.
[Update Guide — Update of SAP Systems Using the Soft-
e |fyou use partner adapters, see SAP Note
ware Update Manager 1.0]
1522700#% for information about their release re-
[Upgrade and Update Guide - SAP NetWeaver 7.5 Java] strictions.
[Upgrade and Update Guide - SAP NetWeaver 7.5 ABAP | ® Modules or adapters that you have developed for
+Java] SAP NetWeaver 7.0 adapter framework, do not
run in the Process Integration framework of SAP
NetWeaver 7.5 PI. During the upgrade of the
adapter framework, you have to replace them by
appropriate versions for the SAP NetWeaver 7.5
Pl adapter framework.
If you cannot upgrade these modules or adapters,
you may use a J2EE Adapter Engine of SAP Net-
Weaver 7.0 as a non-central Adapter Engine in
your SAP NetWeaver 7.5 landscape. To do so, you
have to move all scenarios containing these mod-
ules and adapters to a non-central Adapter Engine
of SAP NetWeaver 7.0 before you upgrade the
central Pl system.
3 You upgrade the standalone Adapter Engine. As this is an AS Java based system, the standard up-
rade procedure and tools for SAP Java systems are
[Update Guide — Update of SAP Systems Using the Soft- g 4 P Y
sed.
ware Update Manager <version>] Y
[Upgrade and Update Guide - SAP NetWeaver 7.5 Java]
4 You upgrade the Adapter Engine (Java SE). The Adapter Engine (Java SE), including the contained
dapters, i | ted f tibilit .
SAP NetWeaver 7.5 Library at http://help.sap.com/ @ -ap ers.1s only supported or compatibliity reasons
It is not developed any further. It should therefore only
nw75#% |l Application Help » Function-Oriented View | o sed in cases where it is unavoidable.
> Process Integration > Adapter-Engine (Java SE) >
Installation }
5 You upgrade Search and Classification (TREX).
[Upgrade Guide — SAP NetWeaver TREX 7.0 to TREX
7.1].
6 You upgrade your SAP GUI installations.
[Installation Guide — SAP Front End]
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Action Remarks / Subsequent Steps

[Required Documentation]

7 If Enterprise Service Repository (ESR) from SAP Net-
Weaver CE 7.1is part of SAP PI, transfer the ESR con-
tent to SAP NetWeaver 7.5 PI ESR.

[Upgrade of System Landscapes Including ES Reposi-
tory for SAP CE [page 63]]

2 If the former SAP Pl system is a dual-stack implementa-
tion, you must carry out after the upgrade of SAP Pl to
SAP NetWeaver 7.5 the dual-stack-split using the soft-
ware provisioning manager for the dual stack-split pro-
cedure and the Pl Upgrade CTC Wizard for the configu-
ration adjustment.

Dual-Stack Split Guide (Software Provisioning Manager)
SAP Note 2190371#% for CTC

[Upgrade and Update Guide - SAP NetWeaver 7.5 ABAP
+Java]

8 You perform the follow-up activities and thedelta con-
figuration [page 75].

[Upgrade and Update Guide - SAP NetWeaver 7.5 ABAP
+Java]

[Upgrade and Update Guide - SAP NetWeaver 7.5 Java]

The following table shows the procedure depending on the source release and technology of a PI Dual-Stack
system:

Table 24:
Source Release Technology Procedure
7.00,7.01,7.02 Java upgrade
ABAP upgrade
7.10,7.11,7.30,7,31,7.40 Java enhancement package installation
ABAP upgrade
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41.3.2 Upgrade of System Landscapes Including ES
Repository for SAP CE

Use

If your source release system landscape contains an "Enterprise Services Repository for SAP NetWeaver
Composition Environment 7.1" (ESR) and Process Integration (or you intend to use Process Integration), you
should discontinue using this ESR. Instead, use the ESR included in SAP NetWeaver 7.5 Process Integration.

Process

1. Upgrade to SAP PI7.5.

2. Transport the ESR content from SAP CE to SAP Pl either using the Change Management Server (CMS) of SAP
NetWeaver DI, or using the file system. For more information, see the SAP NetWeaver 7.5 Library at http://

help.sap.com/nw75% s Application Help » SAP Process Integration » Administrative Tasks »

Transporting ESR Content and Objects of Integration Directory 3

3. You manually have to assign users to the user groups of the SAP PI ESR since these cannot be transferred
from the SAP CE ESR.

4.1.4 Upgrade of Scenarios Based on SAP Composition
Environment

Below you will find information about upgrading scenarios that are based on SAP Composition Environment. This
section is relevant for you if you use SAP NetWeaver Composition Environment 7.1, 7.1 including enhancement
package lor7.2.

As of SAP NetWeaver 7.3, the functional scope is covered by the use case Building Composite Applications. The
following figure shows which software units make up the use case.
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Figure 12: Building Composite Applications

414.1 Upgrade Sequence

The following table describes the sequence in which you have to perform the upgrade or installation steps.

1 Note

For information about finding the referenced documentation, see section Documentation References [page
77].

Table 25:

Action Remarks / Subsequent Steps

[Required Documentation]

1 You upgrade the SAP Composition Environment | We recommend that you always install the latest
server or Developer Workplace. available SAP NetWeaver 7.5 support package
stack.

[Update Guide — Update of SAP Systems with
Software Update Manager 1.0]

2 You upgrade the SAP NetWeaver Developer Stu-
dio.

[Installation and Update Guide — SAP NetWeaver
Developer Studio 7.5 ]
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Action Remarks / Subsequent Steps

[Required Documentation]

3 Perform the delta configuration [page 75].

4.1.5 Upgrade of Scenarios Based on SAP NetWeaver Mobile

Below you will find information about upgrading scenarios that are based on SAP NetWeaver Mobile.

Depending on your source release, you either have to perform a migration or an upgrade to the target release:

e Source release SAP NetWeaver 7.0: Since the system landscape and software architecture changed, you
need to perform a migration. For information about the migration procedure, see the Migration Guide — SAP
NetWeaver Mobile 7.1.

e SAP NetWeaver Mobile 7.1 and SAP NetWeaver Mobile 7.1 including enhancement package 1: You can
upgrade directly to the add-on SAP NetWeaver Mobile on top of SAP NetWeaver 7.5.

1 Note

SAP NetWeaver Mobile is available as add-on for SAP NetWeaver as of SAP enhancement package 1 for
NetWeaver 7.3. If you use SAP NetWeaver Mobile either on SAP NetWeaver 7.10 or on SAP NetWeaver 7.3,
you install the add-on on top of SAP NetWeaver 7.5.

Choose the SAP NetWeaver Mobile add-on while selecting in the SAP Solution Manager Maintenance
Optimizer the files, which are necessary for the upgrade. The further upgrade steps are outlined below in
section Upgrade Sequence.

For more information about the installation of the add-on SAP NetWeaver Mobile, see SAP Note 1645275
P

As of SAP NetWeaver 7.3, the functional scope is covered by the use case Mobilizing Business Processes. The
following figure shows the software units that make up the use case.
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4151 Upgrade Sequence

The following table describes the sequence of upgrade steps for upgrading from SAP NetWeaver Mobile 7.1 and
SAP NetWeaver Mobile 7.1 including enhancement package 1 to SAP NetWeaver 7.5.
Caution

As of SAP enhancement package 1 for SAP NetWeaver 7.3, SAP NetWeaver Mobile is only available as add-on.
See SAP Note 1645275 for further information about installing SAP enhancement package 1 for SAP
NetWeaver Mobile 7.3.

1 Note

For information about finding the referenced documentation, see section Documentation References [page
77].

Table 26:

Action Remarks and Subsequent Steps
[Corresponding Documentation] [Corresponding Documentation]

1 You upgrade the SAP NetWeaver Mobile server. e \Werecommend that you always install the latest

) ) available SAP NetWeaver 7.5 support package
[Update Guide — Update of SAP Systems Using Soft- stack
ware Update Manager <version>] ' _
e Forthe upgrade from SAP NetWeaver Mobile 7.1
[Upgrade and Update Guide - SAP NetWeaver 7.5 to SAP NetWeaver 7.5, make sure that SAP Net-
ABAP] Weaver Mobile 7.1 includes at least SPS 04 or
higher.
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Action Remarks and Subsequent Steps

[Corresponding Documentation] [Corresponding Documentation]
2 You generate the software component versions

(SWCV).

You must regenerate all the data objects that are part
of the SAP Basis 7.10 software component version
along with other application-specific software compo-
nent versions.

3 You configure the Data Orchestration Engine (DOE).
See SAP Help Library athttp://help.sap.com/nw75
|} Application Help > SAP NetWeaver Mobile >
Configuring SAP NetWeaver Mobile > Configuring
SAP NetWeaver AS » Performing DOE Initial Setup
and Configuration 4

4 If existing in your landscape, you upgrade your AS
Java-based systems with product instance DI or En-
terprise Portal.

[Upgrade and Update Guide - SAP NetWeaver 7.5
Java)

[Update Guide — Update of SAP Systems Using Soft-
ware Update Manager <version>]
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Action Remarks and Subsequent Steps

[Corresponding Documentation] [Corresponding Documentation]

5 You upgrade your mobile clients (if SAP Mobile Cli-
ents are used):

1. Download patches from SAP Service Market-
place and then upload them to the Data Orches-
tration Engine.

See SAP Help Library at http://help.sap.com/

nw75|} Application Help > SAP NetWeaver
Mobile > Administering SAP NetWeaver Mobile

» Software Logistics 4

2. Apply patches.
You assign the patches to the client devices,
which makes them available in the outbound
queues of the devices. On the next synchroniza-
tion of the client with the DOE, the patch is down-
loaded to the client device. The client installer ap-
plies the patches on the client, and then auto-
matically restarts the client.
See SAP Help Library at http://help.sap.com/

nw75¢ | Application Help » SAP NetWeaver
Mobile > Administering SAP NetWeaver Mobile
> Software Logistics > Applying Patches >
Applying Patches on the Mobile Client ]

6 You upgrade your SAP GUI installations.

[Installation Guide — SAP Front End ]

4.1.6 Upgrade of SAP Knowledge Warehouse

Below you will find information about upgrading SAP Knowledge Warehouse. This section is relevant for you if you
used one of the following scenarios:

e SAP NetWeaver 7.0: IT scenario Documentation, Training Materials and Manuals Management

1 Note

As of SAP NetWeaver 7.0, SAP Knowledge Warehouse (SAP KW) is an integral part of SAP NetWeaver
Application Server.

For more information, see the SAP Note 1406422 ¥ .
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The following figure shows a typical system landscape for SAP Knowledge Warehouse:
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Figure 14: SAP Knowledge Warehouse

416.1 Upgrade Preparation

Perform the following preparations before you start the upgrade of your SAP Knowledge Warehouse system.

416.11 Backing Up the SAP System and the SAP Content
Server

Before you start the upgrade, create a backup of the SAP system (ABAP+Java dual-stack system) and of all SAP
Content Servers. The SAP system and the SAP Content Servers must be in a consistent state when you perform
the backup. We recommend that you create the backup after you have made the last changes to your production
data. Otherwise, data could be lost if problems occur during the upgrade.

If your Application Server Java is installed as a standalone system, you need to create a backup for this system as
well.

Make sure that you also create a backup of the MaxDB instance related to the SAP Content. The further usage of
the SAP KW content is only possible, if the latest files stored in the SAP Content Server fit to the metadata stored
in the SAP system and vice versa.

416.1.2 Saving the SAP Content Server Configuration File

Create a copy of the file contentserver.ini (on Windows) or cs. conf (on Unix). This file contains information
about the repositories stored in the MaxDB (formerly SAP DB) instance. You can find it in the home directory of
the SAP Content Server Web site. Save the copy of the file in a different directory from the original one.

This file is especially important as it contains information about already existing content repositories in the SAP
Content Server.
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41.6.1.3

Knowledge Servlet

Saving Customer-Specific Changes to the Internet

If you have made changes to the display component of the SAP Knowledge Warehouse, the Internet Knowledge
Servlet (IKS), for example, if you changed the graphics in the banner to meet your requirements for corporate
identity, save a version of the SCA (Software Component Archive) of the source release IKS so you can apply your
changes to the IKS-SCA of your target release.

1 Note

SAP ITS is no longer required.

416.2 Upgrade Sequence

The following table describes sequence in which you have to perform the upgrade or installation steps.

1 Note

For information about finding the referenced documentation, see section Documentation References [page

77].

Table 27:

Action

[Corresponding Documentation]

Remarks and Subsequent Steps

[Corresponding Documentation]

1 Upgrade the Application Sever ABAP and Application We recommend that you always install the latest availa-
Server Java. ble SAP NetWeaver 7.5 support package stack.
[Upgrade and Update Guide - SAP NetWeaver 7.5 ABAP]
[Upgrade and Update Guide - SAP NetWeaver 7.5 Java]
[Update Guide — Update of SAP Systems Using Software
Update Manager <version>]
2 Uninstall older versions of SAP Gateway. An SAP Gateway is only required if SAP Content Server
is installed on a different server than the AS ABAP in-
stance. Otherwise, the gateway of the existing SAP in-
stance can be used.
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Action

[Corresponding Documentation]

Uninstall the SAP Internet Transaction Server if it exists.
To uninstall an ITS instance that is only used for your

KW system, proceed as follows:

1. Start the Microsoft Management Console.
Close the ITS Web site.

3. Choose Save and close the Microsoft Management
Console.

4. Choose |} Start > Settings > Control Panel >
Add/Remove Programs > Internet Transaction

Server }

Remarks and Subsequent Steps

[Corresponding Documentation]

1 Note

A standalone instance of SAP ITS only exists for very
low Support Package levels of SAP Web Application
Server 6.40 (lower than SPS13). If your system has a
higher Support Package level or is already on SAP
NetWeaver release 7.0, no activity is required here.

Upgrade the SAP Content Server and Cache Server (if
used).

[Installation Guide SAP Content Server 6.40]

For SAP Knowledge Warehouse, the content has to be
stored in a MaxDB database. The upgrade of SAP Con-
tent Server may also require an upgrade of the MaxDB
instance. For information about the supported combina-
tions of SAP Content Server, operating system and
MaxDB version, see the Product Availability Matrix at

http://service.sap.com/pam#r.

If SAP Content Server is installed on a different server
than the SAP Web AS, you can perform the upgrade ac-
tivities in parallel.

If the Content Server configuration file has been
changed by these actions, then use the configuration
file from the preparation step to have access to the re-
positories again. Do not try to re-create them.

Install SAP Gateway, if SAP Gateway is not already in-
stalled on your system.

[Installation Guide — Standalone Gateway on <Operating
System> — For SAP Systems Based on SAP NetWeaver
7.5]

If SAP Content Server is installed on the same host as
the SAP NetWeaver Application Server ABAP, you do
not need to install the SAP Gateway.

SAP NetWeaver Upgrade Master Guide
Upgrading, Configuration, and Follow-Up Activities

PUBLIC 71


http://help.sap.com/disclaimer?site=http://service.sap.com/pam

Action Remarks and Subsequent Steps

[Corresponding Documentation]

[Corresponding Documentation]

6 Install or update to SAP NetWeaver Search and Classifi-
cation (TREX).

Installation or upgrade to a higher TREX release is only
required if you want to use the full text or attribute

h ilities of SAP KW.
[nstallation Guide — SAP NetWeaver 7.1 TREX Single | Scarc capabilities of S

Host
1 Note

Installation Guide — SAP NetWeaver 7.1 TREX Multiple

Hosts

Upgrade Guide — TREX 6.1 to SAP NetWeaver 7.0 TREX
(TREX 7.0)]

TREX 7.1is supported on a restricted number of op-
erating systems. For more information, see the Prod-
uct Availability Matrix (PAM) at http://serv-

ice.sap.com/pam fr .

Upgrade Guide — TREX 7.0 to SAP NetWeaver 7.1 TREX
(TREX 7.1)]

7 Check the configuration of your SAP Knowledge Ware-
house. For information about the configuration, see SAP
Note 1287381 ¢k .

41.6.3 Follow-Up Activities

SAP KW Configuration

For information about the configuration of the SAP Knowledge Warehouse scenarios, see SAP Note 1287381 .

Perform function tests for the SAP KW scenarios

You perform function tests for the SAP Knowledge Warehouse scenarios (such as Editing of Content or Printing of
Structures), which are used in your environment.

If you have a specific version of the SAP KW display component (see Saving Customer-Specific Changes to the
Internet Knowledge Servl [page 70]), then only the SAP standard IKS is available after the upgrade. You have to
apply your changes to the IKS of the target release and deploy them by means of the Software Deployment
Manager (SDM).
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4.1.7 Custom Application Development (ABAP)

Use

The Application Server ABAP provides the ABAP foundation of SAP NetWeaver. AS ABAP provides a complete
development and runtime environment for ABAP-based applications. It is optimized for the development of highly
scalable business applications.

SAP delivers a vast number of standard Business applications such as the SAP Business Suite and Industry
solutions, on the ABAP platform, meeting the standard enterprise business requirements. However, there are
always certain processes and scenarios in an enterprise, which are customer-specific. These specific processes
and scenarios enable customers to differentiate their business and further leverage their competitive advantage.
To meet these customer-specific needs the Application Server ABAP development and runtime environment
offers extensive tools and services for the development of ABAP based applications. In addition to the
comprehensive development tools support, the Application Server ABAP also offers capabilities for process &
memory administration, multi-user management, database connections and more.

An end to end lifecycle management support equips customers with services & tools, for example for system
landscape management, configuration, transport management, offering support at every stage of the application
lifecycle, from prototype to go-live and thereafter.

Application Server ABAP 7.5 offers various new enhancements for the Custom Application Development (ABAP)
use case. These new enhancements can be broadly categorized into two main areas:

e Core ABAP enhancements
for example for enhancements in the ABAP programing language, Eclipse-based ABAP development
environment and tools.

e SAP HANA based developments
to take advantage of SAP HANA specific features from ABAP such as: New ABAP Profiler to detect code
optimization potential for SAP HANA, Enhanced ABAP List Viewer (ALV) for SAP HANA, ABAP managed
database procedures (AMDP), Core Data Services (CDS).

The data layer of SAP NetWeaver 7.5 is based on Core Data Services (CDS). For SAP NetWeaver 7.5, Core Data
Services have been extended in many different ways (such as annotations, extensions, built-in functions, table
functions) which allows you to develop modern ABAP applications with a compelling user interface based on SAP
UI5. The ABAP developer tools help you to prototype the CDS layer quickly with many built-in templates and
wizards.

The ABAP development and runtime environment makes it possible to develop complex business applications
without having to worry explicitly about technical details such as process or memory administration, multi-user
capability, database connections, or similar issues. These are provided in the basic services of the Application
Server ABAP or are integrated directly in the ABAP runtime. The application development is similarly independent
of the underlying platform. The application server decouples the application coding completely from the operating
system and database that are used. Using ABAP, you can run custom development projects to create and
enhance business functions in the backend, and you can develop applications using various SAP Ul technologies
such as SAP UI5 or Floor Plan Manager (FPM), and Web Dynpro ABAP applications to meet different scenario
requirements.

The Application Server ABAP 7.5 brings with it several innovations and enhancements. The main area of
innovation focus has been on enabling the Application Server ABAP to harness the power of SAP HANA database
for OLAP- and OLTP-based application scenarios. Application Server ABAP 7.5 further on, remains compatible
with traditional relational databases.
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The new core ABAP enhancements focus on providing a rich ABAP developer experience

As shown in the figure below, the system landscape provides additional components for the Custom Application
Development scenario:

e SAP HANA database
e ABAP Development Tools for SAP NetWeaver

Design Time Environment

Client

SAP GUI ABAP Development Tools (Eclipse)

ABAP Platform Layer

Application Server ABAP

Database Layer
Classic DB or SAP HANA DB

Figure 15: Software layers and components that are used in the Custom Application Development scenario

So that optimum benefit can be achieved from running productive Business Suite systems on SAP HANA DB, the
AS ABAP provides support for the migration to SAP HANA DB. A combination of new ABAP code scans as well as
monitoring and analysis tools enables the developer to find ABAP SQL code that has potential for performance
improvement (ABAP for HANA performance optimization).

With ABAP Development Tools for SAP NetWeaver, a new development environment - as an addition to the ABAP
Workbench (SAP GUI) - is at the disposal of the ABAP developer in the classic Custom Application Development
scenario. It is based on the open platform Eclipse and targets a significant increase in development productivity in
all phases of ABAP-based software projects. It combines the strengths of the close integration of development,
test, and quality-assurance tools with the application server AS ABAP; this includes the stable and proven ABAP
Lifecycle Management process - with the advantages of a comfortable and lightweight Eclipse Ul and a
standardized user interaction process.

ABAP Development Tools play a central role in the integration of the SAP HANA repository contents within the
ABAP platform layer. So that native access to models from the SAP HANA repository is possible from within

ABAP, appropriate proxies can be generated as development objects and handled in the same way as other ABAP
repository objects.
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More Information

For more information regarding Custom Application Development (ABAP), see the Help Portal at:

e http://help.sap.com/nw75¢%|» Application Help ¥ Function-Oriented View ¥ Application Server
Application Server ABAP » Application Development on AS ABAP 3
e http://scn.sap.com/community/abap
e http://scn.sap.com/community/netweaver-as
In terms of the implementation of SAP NetWeaver Application Server ABAP 7.5 based on SAP HANA, see the End-
to-End Implementation Roadmap for SAP NetWeaver AS ABAP. This guide is available on the Service Marketplace
at http://service.sap.com/installnw75#%|p Planning 3.

4.2 Configuration of Systems and Follow-Up Activities

After the upgrade, new and changed functions may require you to adjust your Customizing and the configuration
of your systems. For information about new, changed or enhanced functions, see the Release Notes available at

http://help.sap.com/nw75#% | What's New — Release Notes 3. In addition, several follow-up activities are
required.

Configuration

The SAP Solution Manager contains descriptions of all configuration tasks, and leads you to automated
configuration procedures, where available.

For more information about configuration activities, check the SAP NetWeaver 7.5 library at http://help.sap.com/
nw75% | Application Help » Function-Oriented View ¥ <Software Unit> 3.

1 Note
Accessing Use Case information in SAP Solution Manager

You can use the business process repository browser (BPR browser) in SAP Solution Manager at https://
implementationcontent.sap.com/bpr# to access instantly information about the SAP NetWeaver 7.5 use
cases you want to implement:

e Choose | Business Process Repository j# Solutions/Applications » SAP NetWeaver Jto access centrally
all SAP NetWeaver 7.5 use cases.

e Choose | Business Process Repository ¥ Solutions/Applications » SAP Technology » ->End-To-End Use

Cases Jto access end-to-end implementation information about Application Life-Cycle Management and
Enterprise Data Warehousing.

Process Integration

Instead of creating your configuration guides with the SAP Solution Manager, you can also find the
configuration information in the SAP Help Portal. Access the SAP NetWeaver 75 Library at: http://
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help.sap.com/nw75% | Application Help » Function-Oriented View » Process Integration » Configuring

Process Integration After Installation 3.

1. For configuring the Process Integration (PI) dual usage type installation, choose |+ Configuring Process

Integration (Pl) Dual Stack » Basic Configuration for SAP Process Integration (Pl) 4.
o For configuring the Non-Central Advanced Adapter Engine (PI-AF) for Pl dual usage type installation,

choose |+ Configuring the Non-Central Advanced Adapter Engine (PI-AF) .
2. For configuring the Advanced Adapter Engine Extended (PI-AEX), choose | Configuring Advanced Adapter
Engine Extended (PI-AEX) #» Basic Configuration for SAP Pl Advanced Adapter Engine Extended .
o For configuring the Advanced Adapter Engine Extended (PI-AF) for AEX, choose | Configuring the
Non-Central Advanced Adapter Engine (PI-AF) for AEX 3.
3. For configuring the Process Orchestration (PI-CP), choose | Configuring Process Orchestration (PI-CP) 1.

Follow-Up Activities

For further follow-up activities, check the section Follow-Up Activities in the Update Guide Update of SAP Systems
Using Software Update Manager <version>. You can find the latest version of this guide on SAP Service

Marketplace at http://service.sap.com/sltoolset®|l Software Logistics Toolset 1.0 » Documentation » System
Maintenance » Updating SAP Systems Using Software Update Manager <Version> .
In addition, for further follow-up activities with regard to SAP NetWeaver key areas such as Process Integration or

Business Warehouse, you need to check the Upgrade and Update Guide - SAP NetWeaver 7.5 <Technology>,
available on the SAP Service Marketplace at http://service.sap.com/upgradenw75#r .
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A Appendix

A.1l Documentation References

The following table contains a list of all documentation referenced in this document and information about where

tofind it.

Table 28:

Title

SAP NetWeaver 75 Library

Location

See SAP Help Portal at http://help.sap.com/nw75#

SUM Guide: Update Guide — Updating SAP Systems Using Soft-
ware Update Manager 1.0 SP<Support Package> <Technology>
<Operating System> <Database>

See SAP Service Marketplace at http://service.sap.com/
sltoolset# [ Software Logistics Toolset 1.0 b3
Documentation ¥ System Maintenance ¥ Updating SAP
Systems Using Software Update Manager <Version> |

SAP NetWeaver 7.5 Update and Upgrade Guides for ABAP,
Java, ABAP+Java: Upgrade and Update Guide - SAP NetWeaver
7.5 <Technology>

See SAP Service Marketplace at http://service.sap.com/
upgradenw75#r

Maintenance Planning Guide

See SAP Community Network at http://wiki.scn.sap.com/
wiki/x/ViwgCw# |l column “Guides" 3

Master Guide — SAP NetWeaver 7.5

Installing and Updating TREX 7.1 Single Host

Installing TREX 7.1 Multiple Host

See SAP Service Marketplace at http://service.sap.com/
installnw75 P
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Title

Migration Guide — SAP NetWeaver Mobile

Location
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Title

Upgrade Guide — TREX 6.1 to SAP NetWeaver 7.0 TREX (TREX
7.0)

Location
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Title

Upgrade Guide — TREX 7.0 to TREX 7.1 TREX

Location

A.2 Additional Information for Implementing SAP NetWeaver

The following table contains links to information available on SAP Service Marketplace or in the SAP Library which

is relevant for implementing SAP NetWeaver:
Table 29:

Content

The latest version of the installation and upgrade guides for
SAP NetWeaver 7.5

Location on SAP Service Marketplace or in SAP Library

http://service.sap.com/instguidesnw75
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Content

Location on SAP Service Marketplace or in SAP Library

System Copy Guides for different Releases

e SAP NetWeaver 7.0
http://service.sap.com/instalInw7OP‘§r|} Installation —

SAP NetWeaver Systems }

e  SAP NetWeaver CE 7.1: http://service.sap.com/instgui-
desnwce71#r

e  SAP NetWeaver CE 7.1 including enhancement package 1:
http://service.sap.com/instguidesnwce711#

e SAP NetWeaver CE 7.2: http://service.sap.com/
installnwce72

e  SAP NetWeaver Process Integration 7.1: http://serv-
ice.sap.com/installnwpi71

o SAP NetWeaver Mobile 7.1: http://service.sap.com/
installnwmobile71#r

Information about security

SAP Security Guide: See the SAP Library at http://
help.sap.com/nw75fb’|} Security Information > Security
Guide 3.

Information about the technical operation of SAP NetWeaver

Technical Operations Manual: See the SAP Library at http://
help.sap.com/nw75fblb System Administration and
Maintenance Information > Technical Operations for SAP

NetWeaver 1

Information about SAP NetWeaver Support Package Stacks

http://support.sap.com/sp-stacksFr

SAP Support Portal: Single Point of Access for Upgrade-Re-
lated Information

https://support.sap.com/release-upgrade-maintenance/

upgrade-info.htm|Fr

Information about SAP NetWeaver Capabilities

® http://scn.sap.com/community/netweaver i

e http://scn.sap.com/docs/DOC-8287 ¥

° http://help.sap.com/nw75fb’|} Application Help }

SAP Solution Manager Guides

All SAP Solution Manager related guides, such as
e Master Guide
e Configuration Guide
e Security Guide Master Guide
e Upgrade Guide

e Solutions Operations Guide

are available at:http://service.sap.Com/instguidesfhvlb
Installation & Upgrade Guides > SAP Components > SAP
Solution Manager > <Release> ]

82 PUBLIC

SAP NetWeaver Upgrade Master Guide
Appendix


http://help.sap.com/disclaimer?site=http://service.sap.com/installnw70
http://help.sap.com/disclaimer?site=http://service.sap.com/instguidesnwce71
http://help.sap.com/disclaimer?site=http://service.sap.com/instguidesnwce71
http://help.sap.com/disclaimer?site=http://service.sap.com/instguidesnwce711
http://help.sap.com/disclaimer?site=http://service.sap.com/installnwce72
http://help.sap.com/disclaimer?site=http://service.sap.com/installnwce72
http://help.sap.com/disclaimer?site=http://service.sap.com/installnwpi71
http://help.sap.com/disclaimer?site=http://service.sap.com/installnwpi71
http://help.sap.com/disclaimer?site=http://service.sap.com/installnwmobile71
http://help.sap.com/disclaimer?site=http://service.sap.com/installnwmobile71
http://help.sap.com/disclaimer?site=http://help.sap.com/nw75
http://help.sap.com/disclaimer?site=http://help.sap.com/nw75
http://help.sap.com/disclaimer?site=http://help.sap.com/nw75
http://help.sap.com/disclaimer?site=http://help.sap.com/nw75
http://help.sap.com/disclaimer?site=http://support.sap.com/sp-stacks
http://help.sap.com/disclaimer?site=https://support.sap.com/release-upgrade-maintenance/upgrade-info.html
http://help.sap.com/disclaimer?site=https://support.sap.com/release-upgrade-maintenance/upgrade-info.html
http://help.sap.com/disclaimer?site=http://scn.sap.com/community/netweaver
http://help.sap.com/disclaimer?site=http://scn.sap.com/docs/DOC-8287
http://help.sap.com/disclaimer?site=http://help.sap.com/nw75
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides

Content Location on SAP Service Marketplace or in SAP Library

Information about Maintenance Tools: Maintenance Planner | See SAP Community Network at http://wiki.scn.sap.com/
and Maintenance Optimizer wiki/x/VIwgCw

A.3 Description of Software Units

The following sections provide more details about product instances, standalone engines, optional standalone
units and clients of SAP NetWeaver.
1 Note
Usage Type, Technical Usage, and Product Instance

The term product instance replaces the terms usage type and technical usage for SAP systems based on SAP
NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731# .
Note that there is no terminology change for older releases and all mentioned terms can be used as synonyms.

Caution
Uninstalling additional product instance

Note that it is not possible to uninstall additional product instances and that this is also not supported by SAP.
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A.3.1 Systems with Product Instances

Java Product Instances

The Java product instances are all based on Application Server Java (BASIC). Further dependencies exists that
are shown in the following figure:

Business Process
Management and
Bl Java (BI) Business Rules
Management
(BPM)

Composition

Environment

Platform (CE-
ENV)

Enterprise Portal

PDF Export

Central Process Enterprise EP Core —
Scheduling Services Application Portal
(JOB-SCHED) Repository (ESR) (EPC)

Development
Infrastructure

(D)

Adobe Document
Services (ADOBE)

Application
Server Java

(BASIC)

Figure 16: Java Product Instances

For more information and installation instructions, see the SUM guide for Java: Update Guide — Updating SAP
Systems Using Software Update Manager, for: Java, section Installing Additional Product Instances in an Existing
SAP System.

Compatibility Product Instances

Apart from the product instances described here, there are some discontinued product instances. If these
product instances are installed in your source release system, they are preserved during the upgrade. However,
they are not part of a new installation of SAP NetWeaver 7.5. For more information, see Compatibility Product
Instances [page 101].

Adobe Document Services (ADS)

Adobe Document Services is a set of runtime services that provide a range of form and document creation and
manipulation functions such as:

e Converting XML form templates (created using Adobe LiveCycle Designer) to PDF and various print formats

e Setting Adobe Reader rights to enable users to fill in and annotate forms, save and print them locally, and
include digital signatures for authentication using the free Adobe Reader software

e [Extracting data from SAP applications into Interactive Forms and transferring form data back into SAP
applications using XML
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Dependencies

Adobe document services depends on Application Server Java.

Functional Units

Adobe Document Services comprises the identically named functional unit.
Application Server ABAP (AS ABAP)

SAP NetWeaver Application Server for ABAP provides a complete development and runtime environment for
ABAP-based applications. It is optimized for the development of highly scalable business applications. The ABAP
development environment is used both for developing completely new applications and extending and modifying
SAP standard applications for customers. The entire, powerful infrastructure of the Application Server for ABAP
can be used, which even supports the creation of the most complex applications by large groups of developers.

Application Server Java (BASIC)

AS Java is used to provide the Java foundation of SAP NetWeaver using the Java Engine, a Java EE-compliant
application server for running enterprise applications. In addition to the pure Java EE standard technologies, the
Java Engine implements complementary technologies such as Web Dynpro or Web Services.

Dependencies
AS Java can be combined optionally with other Java-based product instances in one system.
Functional Units

Application Server Java comprises the following functional units:

Table 30:
Functional Unit Description
CM Services (Change Management Services) CM Services help you to manage your Java development.

They provide services for creating development configura-
tions, for importing and exporting, and for the deployment to
runtime systems. CM Services enable you to set up team de-
velopment with centrally managed development configura-
tions. It also supports the automated deployment of build re-
sults on to central runtime system. The import and export
service enables you to import and export Software Compo-
nent Archives (SCAs) of a development configuration. When a
transport system is needed, a development configuration can
be integrated into the Change and Transport System (CTS+).
To use CM Services, product instance Dl is required.

Java Data Archiving Java Data Archiving provides APIs to allow Java applications

to connect to the XML Data Archiving Service for data archiv-
ing solutions. Java archiving is required for Java applications
with a large volume of retention-relevant data.
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Functional Unit Description

Java Foundation This is the Java foundation of SAP NetWeaver. Among its ca-
pabilities is the JEE Engine, a J2EE-compliant application
server for running enterprise applications. In addition to the
pure JEE standard technologies, the JEE Engine implements
complementary technologies, such as Web Dynpro or Web
Services, that are targeted at supporting large-scale, real-
business application development projects.

Services Registry The Services Registry is a registry for Web services. Located
centrally within an SOA landscape, it contains entries for all
services and service definitions in that landscape. The regis-
tered services are classified using semantic-rich classification
systems to enable the browsing of services by classification.

System Landscape Directory The System Landscape Directory (SLD) of SAP NetWeaver
serves as a central information repository for your system
landscape. A system landscape consists of hardware and soft-
ware components that depend on each other with regard to
installation, software updates, and demands on interfaces.
The information in the SLD is used by various SAP tools.

XML Data Archiving Service The XML Data Archiving Service (XML DAS) enables data to
be stored using the WebDAV Storage Interface for the ILM
Solution from SAP as certified in the interface BC-ILM. It al-
lows both XML-sensitive storage used for JAVA Archiving or
XML Archiving (see corresponding Functional units) and ILM
aware archiving used in SAP NetWeaver ILM.

Bl Java (BI)
Bl Java provides the Java runtime for several BW capabilities.
Dependencies

Bl Java requires AS Java, EP Core — Application Portal, and Enterprise Portal in the same system. Usually,
scenarios running on product instance Bl Java also require product instance BW ABAP. While installing Bl Java,
the required product instances are installed automatically. After configuring Bl Java, you do not need to perform
further steps in AS Java, EP Core — Application Portal, and Enterprise Portal.

Functional Units
Bl Java comprises the identically named functional unit.
Business Process Management and Business Rules Management

Business Process Management supports the process collaboration and creation of new innovative business
processes based on standardized core processes. SAP Business Process Management enables collaborative
composition of executable business processes based on a process model. Clearly defined business rules can be
incorporated into processes from the outset. The tight integration with Business Rules Management enables
business users with no coding skills to create and modify rules using decision tables.

SAP NetWeaver Upgrade Master Guide
86 PUBLIC Appendix



With Business Rules Management you can author, execute, and manage business rules. The following key
features are offered by Business Rules Management:

® |nference-based rule engine implementing RETE algorithm

e Support of different rules formats (declarative rules, decision table and flow rules)

® Rules Manager: a Web Dynpro Java based rules maintenance tool for business users
e \ersioning and tracking changes of business rules

e Qut-of-the-box Web service generation for rule sets

® Rules testing in the rules composer (NWDS)

e Public API for rules execution

e Tighter integration with Business Process Management

Dependencies

Business Process Management and Business Rule Management requires AS Java and Composition Environment
Platform in the same system.

Functional Units

Business Process Management and Business Rule Management comprise the following functional units:

Table 31:
Functional Unit Description
Process Server Contains the function for Business Process Management
Rules Server Contains the functions for Business Rules Management

Business Warehouse ABAP (BW ABAP)
Business Warehouse provides the infrastructure for the following functions:

e Datawarehousing

® Various analytical technologies and functions

® Business planning functions

e \Web-based and Excel-based reporting, analysis, and planning

e |nformation broadcasting to distribute BEx applications via various channels either as precalculated
documents with past data, or as links with live data

e QOpen analysis interfaces that make available various interfaces for connecting front-end tools of third-party
providers

Dependencies

BW requires AS ABAP as a prerequisite in the same system.

1 Note

For product instance BW, there is no installation option in the software provisioning manager 1.0.
Instead, install AS ABAP with software provisioning manager 1.0 andthen SAP NetWeaver 7.4 B
Content 7.57 or SAP NetWeaver 7.4 Bl Content Extensions add-on 7.57. This version of Bl Content add-on will
be used for providing additional data flows that use the new BW features delivered via SAP NetWeaver 7.4 SPS
05 and higher.
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If you use the already existing Bl Content Add-on 7.57 (SPO5 and higher), there is nothing much to do. But we
recommend upgrading to the latest available SP of this Bl Content Add-on 7.57

Central Process Scheduling by Redwood (JOB-SCHED)

SAP Central Process Scheduling adds powerful cross-component scheduling functionality to the integration
capabilities of SAP NetWeaver. SAP Central Process Scheduling has the following key characteristics:

e Centrality
There is only one central instance of this scheduler which takes control over all background processes in the
entire landscape and allows for cross system scheduling.

e Event-Driven Scheduling
Dependencies between background processes can be defined not only time based but also event based.

® Real-Time Execution
All information about jobs is stored centrally and transferred to the remote systems immediately before job
submission.

For more information, see SAP Developer Network at http://scn.sap.com/community/cps-by-redwood .
Dependencies

SAP Central Process Scheduling requires Application Server Java in the same system.

Functional Units

SAP Central Process Scheduling comprises the functional unit Integrated Central Process Scheduling by
Redwood.

Composition Environment Platform (CE-ENV)

The Composition Environment Platform provides a toolset and runtime for efficiently developing, running, and
managing composite applications based on SOA principles. It builds upon proven technologies that have been
enhanced and integrated to provide greater functionality and flexibility. The Composition Environment Platform
offers you the following capabilities:

e User interface (Ul) development: SAP NetWeaver Web Dynpro and SAP NetWeaver Visual Composer
Web Dynpro and Visual Composer are SAP's standard Ul technologies based on the Model View Controller
(MVC) for developing user interfaces. Web Dynpro Java or Visual Composer applications are developed within
the SAP NetWeaver Developer Studio using a model-driven approach that minimizes manual Ul coding and
uses visual tools to design and reuse components.

e Java business object modeling

e Service Simplification and Composition
A graphical modeling capability simplifies and adapts Complex Services for easy consumption in Composition
Environment. This greatly eliminates the need to write code for simplification and data mapping.

Dependencies
Composition Environment Platform requires Application Server Java in the same system.

Functional Units
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Composition Environment Platform comprises the following functional units:

Table 32:

Functional Unit Description

Composition Environment Platform Composition Environment Platform is the foundation for
building and running composite applications.

ECM integration core Enterprise Content Management (ECM) Integration Core facil-
itates the provision and consumption of Enterprise Content
Management services using standardized interfaces. There-
fore, it enables business applications to consume core ECM
services provided by SAP as well as extended ECM services
provided by partners and third-party vendors leveraging their
ECM product offering. Besides the core runtime components,
this functional unit contains the service provider interface
(SPI) for exposing ECM services as well as the application pro-
gramming interface (API) for making use of these services.

ECM Integration Services ECM Integration Services offer additional services on top of
ECM Integration Core functional. These supplementary serv-
ices such as the server for World Wide Web Distributed Au-
thoring and Versioning (WebDAV) can be leveraged by appli-
cations on top of the already exposed ECM services of the
connected service providers.

Visual Composer Visual Composer is a model-driven development tool used to
create Ul screens and Portal content using a drag-and-drop
graphical environment, without the need to write code. Using
Visual Composer you can create standalone applications such
as form views and dashboards or Ul screens, such as Web
Dynpro screens. Visual Composer also provides Portal Con-
tent Modeling capabilities for generating roles, pages, iViews
and other content for the SAP NetWeaver Portal.

Portal Provides basic SAP NetWeaver Portal capabilities excluding
the Web Page Composer capabilities, the data statistics tools
of Portal Activity Reports, and the Activity Data Collector.

Universal Worklist Offers users unified and centralized access to their work and
relevant information from within the portal. It collects tasks
and notifications from multiple provider systems — Business
Workflow, Collaboration Task, Alert Framework, and KM Re-
cent Notifications — and displays them in a single list.

Development Infrastructure (DI)
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Development Infrastructure provides an infrastructure for developing Java-based applications on the SAP
NetWeaver platform and enables versioning of source code, build and lifecycle management of these applications.
Dl takes care of all parts of the development process :

1. Version control system for central management of source code: The Design Time Repository (DTR) is a
distributed version control system used in SAP NetWeaver Development Infrastructure to manage source
code in development and lifecycle management processes.

2. Central build and archive management: The Component Build Service (CBS), gives developers access to the
latest archive versions in a central archive storage and a central build triggered by developers or central
lifecycle management processes.

3. Central landscape and transport management: CM Services enables you to set up team development with
centrally managed development configurations. It also supports the automated deployment of build results
on a central runtime system. The import and export service allow you to import and export Software
Component Archives (SCAs) of a development configuration. If a transport system is needed, a development
configuration can be integrated into the enhanced Change and Transport System (CTS+).

You can also use the Change Management Service (CMS), which gives administrators a central service to set
up development landscapes for all development tasks and manage all transport processes for these tasks in
the same Ul. However, note that CMS is planned to be replaced by the CM Services in future releases.
Therefore, we recommend using CM Services.

Dependencies

e Dlrequires AS Java as a prerequisite in the same system. Optionally, it can be combined with other product
instances in one system. However, depending on the size of the development project and the number of
active developers, DI should use a dedicated system. For further details, see SAP Note 737368 .

You can run the development infrastructure on an AS Java separately from the rest of your runtime systems
in the system landscape for improved scalability.

If you use a development infrastructure, you have to install the Developer Studio feature SAP NetWeaver
Developer Studio Development Infrastructure Client.

Functional Units

DI comprises the functional unit SAP NetWeaver Development Infrastructure providing the above-mentioned
functions.

Enterprise Portal (EP)

Enterprise Portal (EP) provides users with a single, uniform point of access to the applications, services, and
information they need for their daily work. Moreover, the Portal offers business users the features to easily create
and manage portal pages and generate their own content using the following capabilities:

e KM and Web Content Capabilities
EP provides basic document management capabilities and content services within SAP Enterprise Portal
(KM). KM provides the basic capabilities that customers need to run their scenarios, as well as an extension
framework for custom implementations.
These KM capabilities are also integrated into the Web Page Composer environment to enable flexible Web
content management scenarios, bringing relevant information from user-generated content and business
applications together in the portal.

e Portal Add-On with Forums and Wiki Capabilities
On top of EP, you can install the portal add-on including the forums and the wiki application.
The forums application provides a comprehensive range of discussion features, which are particularly
suitable for community scenarios. Forums typically focus on a specific purpose such as support or human
resources or they might offer customers a place to trade product tips and solutions. Intuitive user interfaces
make it easy for users to ask questions, share information, post announcements to the community, escalate
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questions to experts, and to receive updates on posted comments. Users can create draft versions of their
postings, exchange private e-mails with other forum users, and vote in polls.
Wikis provide a framework to easily share and contribute knowledge and information in an intuitive way within
the company. They give employees, customers, suppliers, and partners a framework to collaborative writing,
and help save time by making ideas available, sharing knowledge, and managing related information.

e SAP Fiori
With SAP Enterprise Portal 7.5 customers can now align and renew their Portal experience with the SAP Fiori
UX (launchpad and apps), while leveraging their existing investment in the Portal (iViews, roles, SSO).
For more information about SAP Fiori, see http://scn.sap.com/docs/DOC-41598# , and about SAP Fiori UX,
see http://scn.sap.com/docs/DOC-61694 # .

Dependencies

EP requires EPC and AS Java as a prerequisite in the same system. Optionally, it can be combined with other
product instances in one system.

Functional Units

Enterprise Portal comprises the following functional units:

Table 33:
Functional Unit Description
Knowledge Management Enables portal users to distribute, access, and manage un-

structured information within an organization in a heterogene-
ous repository landscape. Capabilities include collaborative
document authoring and publishing, version management,
search and navigation with taxonomies, automated classifica-
tion and subscription, and more.

Collaboration Brings users, information, and applications together to ensure
successful cooperation and interaction in the portal. These
tools include collaboration rooms, instant messaging, e-mail,
and calendar integration.

Enterprise Services Repository (ESR)

The Enterprise Services Repository (ES Repository) provides a central place where enterprise service definitions
are modeled, stored, and maintained. It supports SAP's concept of building services based on the process
component modeling methodology. The ES Repository offers the following features:

e Support of governed definitions of SOA assets (such as services and data types).

e Support of widely adopted open standards including Web Services and UDDI.
The ES Repository supports SAP-defined Global Data Types based on the Core Component Technical
Specification standards (stack) (CCTS standards (stack)).

® Basis for enabling easy access to enterprise services - described with rich business classifications - when
developing composite applications and business processes.

Dependencies
Enterprise Services Repository requires Application Server Java in the same system.

Functional Units
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Enterprise Services Repository comprises the identically named functional unit providing the above mentioned
capabilities.

EP Core - Application Portal (EPC)

EP Core — Application Portal (EPC) provides the basic portal capabilities for SAP NetWeaver. It provides a uniform
entry point to content and applications in a consistent, role-based manner. It offers a single point of access
through a Web front end to SAP and non-SAP information sources, enterprise applications, information
repositories, databases and services across organizational and technical boundaries — all integrated into a single
user experience. EPC alone provides a leaner portal installation and implementation where the full enterprise
portal capabilities (such as knowledge management tools) are not needed.

The EPC product instance contains the following capabilities that will help you manage your content and
processes:

® The core portal capabilities include various tools and service for managing portal content, users, and
connections to connected systems such as Single-Sign-On, tools for application integration, roles and
permissions, changing the portal look and feel with the new Ajax Framework, and lifecycle management
(transport).

e |ntegration of several SAP Enterprise Portals and third-party portals into one harmonized SAP Enterprise
Portal acting as the single point of access to all the business related applications and services in the
organization.

e Web Page Composer (WPC): this is an integral part of EPC providing powerful capabilities for business users
to easily create and manage enriched portal pages. Web Page Composer supports professionals creating
interactive portal pages.

Dependencies
EPC requires AS Java as a prerequisite in the same system.
Functional Units

EP Core — Application Portal comprises the following functional units:

Table 34:
Portal Provides basic SAP Enterprise Portal capabilities
Universal Worklist Provides the Universal Worklist Capabilities
Mobile

Product instance Mobile is used to enable field personnel to participate in a business process in an “occasionally
connected” mode. Occasionally connected means that a direct connection (using WLAN or GPRS) between the
mobile device and back end is only established at certain times — at synchronization points, when the Mobile
Server (that is, the system with product instance Mobile) and Mobile Client exchange data in order to keep the
server and client updated. This enables the user to perform process tasks completely independently from the
back-end system, which is extremely helpful if a steady connection cannot be guaranteed or might be too
expensive. To realize this product instance, an intelligent application needs to run on each device containing a
user interface, business logic, and data handling. Mobile includes the Data Orchestration Engine (DOE), an ABAP-
based message-oriented middleware. The Data Orchestration Engine consists of the following:

e Adesign time tool for defining data objects and the distribution of data.
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e Aruntime to replicate, synchronize and distribute data between the components of the system landscape.
This includes, for example, messaging, filling queues, and sending data to the back end.

Dependencies

Mobile is not an installable software unit. As of SAP enhancement package 1 for SAP NetWeaver 7.3, SAP
NetWeaver Mobile is available as add-on. To set up a Mobile system, you install and configure AS ABAP. On top of
the AS ABAP system, you install and configure the SAP NetWeaver Mobile add-on separately.

PDF Export

With PDF Export, you can create print versions of lists that are displayed using ALV for Web Dynpro for ABAP
(SAP List Viewer) and ALV for Web Dynpro for Java.

Dependencies
PDF Export depends on Adobe Document Services and AS Java.
Process Integration (PI)

Pl consists of core components that model, design, automate, and integrate processes in one or more application
systems. For the integration of internal and cross-company processes, Pl is used to incorporate all the functions
of what was formerly known as Exchange Infrastructure (XI). In addition, Pl contains core components for cross-
component Business Process Management (ccBPM) for application-embedded and application-unbounded
processes.

Dependencies

Pl requires AS ABAP, AS Java, Pl Adapter Engine, and Enterprise Services Repository as a prerequisite in the
same system.

For installing PI, it is mandatory to have a dedicated Pl system. This applies to development, quality, and
production landscapes. It is a prerequisite that no other system in your system landscape has a higher release
and enhancement package level than the Pl system. If you want to upgrade or install an application in your system
landscape, you first have to make sure that the current release and enhancement package level of the Pl system is
on the same level - if required, you have to upgrade the Pl system first to the new or a higher release. In a
dedicated Pl system, this can be accomplished with a minimum of downtime. Also, the Pl system would not be
affected by the downtime of other product instances running in the same system.

Functional Units
Process Integration comprises the functional unit SAP Process Integration.
Restrictions for Systems with Multiple Product Instances

e |f you have one system with multiple product instances, be aware that we do not provide standard tools for
separating these product instances and distribute them to multiple systems at a later stage. For example, if
you have a system with product instances A and B, you are not able to migrate it with SAP standard tools into
two systems, one with product instance A only and the other with product instance B only.

In addition, we do not provide standard tools for merging multiple systems with different product instances
into one system with multiple product instances at a later stage. If you want to perform these tasks, you
require specific project support. The only exception is the dual-stack split procedure that offers to split an
optional dual-stack system into two separate systems: one based on AS ABAP, the other one based on AS
Java. For more information about the dual-stack split, see http://scn.sap.com/docs/DOC-25162 #r .
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The following figure shows that SAP standard system copy and migration tools do not support you in
separating or merging systems with product instances:

Figure 17: Separating systems with product instances are not supported with SAP standard system copy and migration
tools

Figure 18: Merging systems with product instances are not supported with SAP standard system copy and migration tools

e Although you can use one system for multiple product instances, client restrictions apply to product instance

BW ABAP. For BW ABAP, you should reserve a dedicated client for reporting purposes. In this client, activate
the SAP NetWeaver Bl Content Add-On as required.

A.3.2 Optional Standalone Units

Advanced Adapter Engine (Pl Adapter Engine)

You use the Advanced Adapter Engine to connect to SAP systems (RFC adapter, IDoc Adapter, and ABAP
proxies) and external systems. You use the various adapters in Pl Adapter Engine to convert XML- and HTTP-
based messages to the specific protocol and format required by these systems, and the other way around.
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You can use the following adapters:

e RFC Adapter

e SAP Business Connector Adapter

e File/FTP Adapter

e JDBC Adapter

e JMS Adapter

e SOAP Adapter

e Marketplace Adapter

e Mail Adapter

e RNIF Adapter

e CDIX Adapter

e |Doc Adapter (Advanced Adapter Engine) (adapter type IDOC_AAE
e HTTP Adapter (Advanced Adapter Engine) (adapter type HTTP_AAE)

You can use the Advanced Adapter Engine which is included in the Pl system as a central adapter engine.
Optionally, for performance reasons, you can install a non-central Advanced Adapter Engine on a separate host.

Dependencies

The Advanced Adapter Engine requires AS Java as a prerequisite in the same system. These product instances
are automatically installed when you install the Advanced Adapter Engine.

Functional Units
The Advanced Adapter Engine comprises the functional unit Advanced Adapter Engine.
Advanced Adapter Engine Extended

The installation option Advanced Adapter Engine Extended (AEX) consists of core components to model, design,
automate, and integrate processes in one or more application systems. The Advanced Adapter Engine Extended
provides the following capabilities:

e Connectivity capabilities of the Advanced Adapter Engine (AAE)

e Design and configuration tools to set up scenarios that are based on the AAE. In particular, for design and
configuration you can use the ES Repository and the Integration Directory. The Integration Directory installed
with AEX contains a subset of configuration options required for the configuration of message processing by
the AAE, basically the integrated configuration.

e Mediation capabilities of AAE
You can use the following adapters:

o RFC Adapter

o SAP Business Connector Adapter

o File/FTP Adapter

o JDBC Adapter

o JMS Adapter

o SOAP Adapter

o Marketplace Adapter

o Mail Adapter

o RNIF Adapter

o CDIX Adapter

o |Doc Adapter (Advanced Adapter Engine) (adapter type IDOC_AAE
o HTTP Adapter (Advanced Adapter Engine) (adapter type HTTP_AAE)
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Dependencies

Advanced Adapter Engine Extended requires AS Java, Pl Adapter Engine, and Enterprise Services Repository as a
prerequisite in the same system.

Functional Units
Advanced Adapter Engine Extended comprises the identically named functional unit.
Process Integration (PI)

Pl consists of core components that model, design, automate, and integrate processes in one or more application
systems. For the integration of internal and cross-company processes, Pl is used to incorporate all the functions
of what was formerly known as Exchange Infrastructure (XI). In addition, Pl contains core components for cross-
component Business Process Management (ccBPM) for application-embedded and application-unbounded
processes.

Dependencies

Pl requires AS ABAP, AS Java, Pl Adapter Engine, and Enterprise Services Repository as a prerequisite in the
same system.

For installing PI, it is mandatory to have a dedicated Pl system. This applies to development, quality, and
production landscapes. It is a prerequisite that no other system in your system landscape has a higher release
and enhancement package level than the Pl system. If you want to upgrade or install an application in your system
landscape, you first have to make sure that the current release and enhancement package level of the Pl system is
on the same level - if required, you have to upgrade the Pl system first to the new or a higher release. In a
dedicated PI system, this can be accomplished with a minimum of downtime. Also, the Pl system would not be
affected by the downtime of other product instances running in the same system.

Functional Units

Process Integration comprises the functional unit SAP Process Integration.

A.3.3 Standalone Engines

For SAP NetWeaver, the following standalone engines are available:
Adapter Engine Java SE

Adapter Engine (Java SE) is a separate software unit. You can use it only if you have SAP NetWeaver systems with
product instance Pl in your system landscape. It has to be installed manually. You use the Adapter Engine (Java
SE) to connect to external systems. Using the various adapters in the Adapter Engine (Java SE), XML and HTTP-
based messages can be converted to the specific protocol and format required by such systems, and the other
way around. The Adapter Engine (Java SE) only provides some of these adapters as a standalone version with
restricted functions for operating systems that do not support SAP PI, but that have at least a Java Runtime
Environment 5.0. Therefore, you should use the Adapter Engine (Java SE) only if the platform prerequisites do not
allow you to use the Advanced Adapter Engine.

Content Server

Content Server is a separate server instance that is used to store documents or other types of content related to
SAP applications. The accompanying cache server can cache content if your company operates in several
locations. This reduces load on the wide area network when working with documents.
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SAP Gateway Foundation

As of SAP NetWeaver 7.4 the central software components of SAP Gateway have been directly integrated into
SAP NetWeaver in the form of software component SAP Gateway Foundation (SAP_GWFND). This component is
automatically part of SAP NetWeaver 7.4 and higher.

SAP Gateway Foundation facilitates easier provisioning and consumption of business logic and content of SAP
back-end systems for mobile and web applications. It aims to reduce the complexity and the skill set required to
access SAP data, thereby removing deployment barriers. Simple interfaces also help to shorten development
times.

SAP Gateway Foundation enables people-centric applications to consume SAP Business Suite data through
popular platforms and devices (such as the iPad and Blackberry) in an easy and standards-based manner. Itis a
framework that connects business users to SAP systems using consumer technologies, groupware, and mobile
devices and is based on open standards (such as the Atom Publishing Protocol and OData) that offer simple
services based on the REST principle.

Depending on your development requirements and where you want to develop SAP Gateway Foundation content,
you can install SAP NetWeaver in either an SAP Business Suite back-end system (embedded deployment) or in an
SAP Gateway Foundation hub system (central hub deployment).

For more information, see http://help.sap.com/netweaverl SAP NetWeaver Platform ¥ SAP NetWeaver <your
release> # Application Help » Function-Oriented View » SAP Gateway Foundation (SAP_GWFND) 3.

liveCache

liveCache is a database engine for managing complex objects in scenarios where large volumes of data must be
permanently available and modifiable.

Search and Classification (TREX)

SAP NetWeaver Search and Classification (TREX) offers an integrated set of services. TREX services include
search and retrieval in large document collections, text mining, automatic document classification, and search
and aggregation over structured data in SAP applications. TREX can handle text from documents in numerous
formats, including Microsoft Office and Adobe formats (PDF), and more than 30 languages. TREX search options,
such as exact, Boolean, fuzzy, or linguistic search, and classification options such as query-based or example-
based classification, offer great power and flexibility to end users.

The BW accelerator is based on TREX technology. You need an installation based on 64-bit architecture for the
BW accelerator. The hardware partners provide this variant already preconfigured as the BW accelerator box.
Note that a TREX installation configured for searching in metadata and documents based on 32-bit architecture
cannot be used for the BW accelerator. Accordingly, a BW accelerator box also cannot be used for searching in
metadata and documents. In order to be able to use the search function and the BW accelerator, you need
separate installations.

Web Dispatcher

The Web Dispatcher lies between the Internet and your SAP system. It is the entry point for HTTP(s) requests into
your system, which consists of one or more SAP NetWeaver application servers. As a software Web switch, the
Web dispatcher can reject connections or accept them. When it accepts a connection, it balances the load to
ensure even distribution across the servers.

You can use the Web dispatcher in ABAP/Java systems and in pure Java systems, as well as in pure ABAP
systems.
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Itis also beneficial to use the Web Dispatcher if you do not need security functions (entry point in the demilitarized
zone (DMZ), SSL, URL filtering), but you simply want to balance the load between multiple SAP NetWeaver
Application Server instances.

Since Web Dispatcher is optional for every SAP system, it is not contained in the system landscapes of the use
cases in this documentation.

For more information, see the SAP Library at http://help.sap.com/nw75% | Application Help » SAP Function-
Oriented View ¥ Application Server ¥ Application Server Infrastructure » SAP Web Dispatcher 3.

A.3.4 Clients

With SAP NetWeaver, you can use the front-end clients and tools described below:
Adobe LiveCycle Designer

Adobe LiveCycle Designer enables the creation of forms that combine high-fidelity presentation with XML data
handling. The easy-to-use graphical interface of Adobe LiveCycle Designer enables users to quickly design forms,
maintain form templates, define a form's business logic, make changes, and preview forms before they are
deployed as Adobe PDF files.

SAP NetWeaver Business Client

The SAP NetWeaver Business Client (NWBC) is a high fidelity desktop client that allows users to display their
assigned roles and to launch applications. SAP NetWeaver Business Client offers a unified environment for and a
single point of entry to SAP business applications and technologies. NWBC is ideal for displaying business
applications such as classical SAP GUI Uls, Web Dynpro Uls, BSP pages, and other content using its multiple
rendering engines. NWBC provides role-based access to applications either via the portal or directly using PFCG
roles. In addition to the basic capabilities detailed above, the SAP NetWeaver Business Client makes use of its
tight desktop integration to provide additional benefits such as desktop search functionality. In the newest SAP
NetWeaver Business Client version you will find the improved user interface (Ul) based on the SAP Signature
design. This Ul offers in part an expert-based interactive paradigm and a superior look and feel matching the
expectations of today's users aiming to maximize their daily activities.

The SAP NetWeaver Business Client is one of the main components of the User Interface Add-On for SAP

NetWeaver. For more information, see the SAP Help Portal at http://help.sap.com/nw-uiaddon®|» Application
Help 3.
Business Explorer (Bl Add-On)

Business Explorer provides flexible reporting and analysis tools for strategic analyses and decision-making
support within a company. These tools include query, reporting, and analysis functions. As an employee with
access authorization, you can evaluate past or current data on various levels of detail and from different
perspectives, not only on the Web but also in Microsoft Excel.

You can use Business Explorer Information Broadcasting to distribute Business Intelligence content by e-mail
either as precalculated documents with historical data, or as links with live data. You can also publish it to the SAP
Enterprise Portal.

Additionally to Business Explorer you may want to consider using tools from the SAP BusinessObjects Analysis
family, such as Analysis, edition for Microsoft Office. The SAP BusinessObjects Analysis clients are specifically
designed for the needs of BW users. Note that SAP BusinessObjects products require separate licenses. For more
information on SAP Business Explorer, see http://scn.sap.com/community/business-explorer .
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SAP GUI

SAP offers three different client applications for accessing ABAP applications in SAP systems (such as SAP
NetWeaver systems with product instance AS ABAP). This SAP GUI family consists of:

e SAP GUI for HTML
SAP GUI for HTML is based on the SAP integrated Internet Transaction Server (ITS) which is included in the
installation of SAP NetWeaver systems as of SAP NetWeaver 7.0. On the client side, only a suitable browser
and a virtual machine are required. For information about supported browser versions, see the Product
Availability Matrix on SAP Service Marketplace at http://service.sap.com/pam# .

e SAP GUI for the Java environment (SAP GUI for Java)
SAP GUI for Java is a generic SAP GUI that covers a variety of platforms.
For more information about the installation of SAP GUI for Java, see the documentation Installation Guide -
SAP Front End.

e SAP GUI for the Windows environment (SAP GUI for Windows)
SAP GUI for Windows is SAP's universal client for accessing all SAP applications built on ABAP technology. It
is available on the Microsoft Windows platform only and offers the broadest feature set of all members of the
SAP GUI family.
For more information about the installation of SAP GUI for Windows, see the Installation Guide — SAP Front
End.

SAP GUI also includes optional add-ons, such as the Business Explorer (Bl add-on) and KW add-on, which might
be required to use certain SAP NetWeaver capabilities.

1 Note

Data warehousing: SAP GUI for HTML and SAP GUI for Java do not have all the capabilities of SAP GUI for
Windows. BEx Query Designer, BEx Analyzer and Uls with network controls are not supported with SAP GUI for
HTML and SAP GUI for Java.

The following SAP GUI versions are supported with SAP NetWeaver 7.5:

e SAP GUI for Windows 7.40 (or higher)
e SAP GUI for Java 7.40 (or higher)
e SAPintegrated ITS

For more information about the SAP GUI family, see SAP Community Network at http://scn.sap.com/
community/guife.

Mobile Client

Mobile Client is installed locally on mobile devices, and is equipped with a Web server, a database layer, and a
framework for the mobile applications. Staff working remotely can therefore work offline and do not have to wait
for a network connection to complete time-critical business applications. Product instance Mobile offers tools for
synchronization and data replication that make the data of the mobile device consistent with that of the back-end
system.

Modeling Tools for SAP BW powered by SAP HANA

The Modeling Tools for SAP BW powered by SAP HANA (BW Modeling Tools) represent a modeling IDE
(Integrated Development Environment) build on top of the Eclipse platform.

Its main objective is to support BW model developers in today’s increasingly complex Bl environments by offering
state-of-the-art modeling tools for BW objects such as InfoObjects, DataStoreObjects (advanced), or Queries.
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These tools include integration with SAP HANA modeling and the consumption of SAP HANA elements in BW
Open ODS Views or CompositeProviders with powerful Ul (user interface) capabilities.

SAP NetWeaver Developer Studio

The SAP NetWeaver Developer Studio (NWDS) is SAP's Integrated Development Environment (IDE) for Java and
is based on the open-source tools framework Eclipse 3.5. With the SAP NetWeaver Developer Studio, you can
develop Java EE 5 applications from scratch using the built-in support for new technologies such as EJB 3.0 and
JSF1.2.

ABAP Development Tools for SAP NetWeaver

ABAP Development Tools for SAP NetWeaver is the IDE for ABAP development on the open Eclipse platform. It
combines capabilities of the ABAP Application Server — such as convenient lifecycle management, server-based
development paradigm, full integration, effective testing, and troubleshooting tools — with the Eclipse Ul on top of
the ABAP platform.

For more information about the ABAP Development Tools, see Custom Application Development (ABAP) [page
73]

SAP Enterprise Services Explorer Tool for Microsoft .NET

As part of its service-oriented architecture (SOA) offering, SAP provides a set of consumer tools that allow the
discovery and consumption of enterprise services from various development environments, such as NetWeaver
Developer Studio, Visual Composer, and Microsoft Visual Studio. SAP Enterprise Services Explorer tool for
Microsoft .NET (ES Explorer for .NET) is an add-on for Microsoft Visual Studio 2005 and Microsoft Visual Studio
2008 that helps to leverage SOA by enabling .NET developers to discover SAP enterprise services and consume
them in their applications, as well as publish their own custom services. It is an important element of SAP -
Microsoft interoperability.

To download the tool, access documentation and other resources, see http://scn.sap.com/community/
interoperability/microsoft-net .

For the most up-to-date information about ES Explorer for .NET, see SAP note 1259258 ¥ .
SAP Web IDE

1 Note
The Developer license for SAP NetWeaver customers does not include the right to use SAP Web IDE.

For more information on licensing, see https://scn.sap.com/docs/DOC-65930

SAP Web IDE is a Web-based integrated development tool. It empowers users to rapidly create apps for browsers
and mobile devices. It simplifies the end-to-end application lifecycle, for example, prototyping, development,
packaging, deployment, and customer extensions for SAP Fiori and SAPUI5 applications.

SAP Web IDE aims to increase development productivity by delivering a holistic development experience. Offered
as a cloud solution powered by SAP HANA Cloud Platform, no initial installation is required, and the local IT
infrastructure is untouched. It supports free-style coding, providing strong editors with capabilities of code
completion (SAPUI5, XML and JavaScript), code validation, beautifiers, and more.

In addition, a layout editor with drag-and-drop (WYSIWYG) capabilities further enables acceleration of app
development. Wizard-based templates and sample applications allow users to design new Uls easily and quickly,
following specific best practices. The finalized application can be deployed automatically on SAP HANA Cloud
Platform, an SAP NetWeaver ABAP Server, HCPms, or SMP, or it can be exported manually to any Web server.
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Using its plugin framework, developers can enhance the SAP Web IDE with additional functionality, for example,
the Hybrid Application Toolkit allows users to create, test, and deploy Kapsel-enhanced Apache Cordova apps,
the SAP Fiori Overview Page plugin (OVP for creating and modifying OVP smart templates apps), the VizPacker
plugin for the creation of Analytics visual extensions, and more.

A.4 Compatibility Product Instances

Compatibility product instances are product instances that have been discontinued and are therefore not part of
the standard SAP NetWeaver installation. If you upgrade from a previous release, these product instances will of
course still exist in your systems if they have been present in the source release system.

There might be reasons for which you want to install these product instances. You can do this using the Software
Update Manager. Note that you can install these product instances only on existing SAP NetWeaver 7.5 Java
systems with at least product instance AS Java.

For more information and installation instructions, see the SUM guide for Java: Update Guide — Updating SAP
Systems Using Software Update Manager, for: Java, section Installing Additional Product Instances in an Existing
SAP System.

Demo Applications

Demo Applications illustrate the usage of SAP Composition Environment for previous releases.

Guided Procedures

Guided Procedures is a framework for modeling and managing workflows using simple and user-friendly tools.
Guided Procedures enables access to multiple backend systems, consistently combining different types of
services and applications into processes. In addition, Guided Procedures supports collaboration, ad-hoc items,
and offline task management using interactive forms. It provides role-based access to tools and resources and
guidance through the workflows at runtime, thereby helping end users to easily identify and complete their tasks.

Dependencies

Guided Procedures require Application Server Java, Composition Application Framework, Composition
Environment Platform as a prerequisite in the same system.

Functional Units

Guided Procedures comprise the identically named functional unit providing the above mentioned capabilities.

NWDS Update Site

You use the NWDS update site when you develop composite applications using several Developer Studio
installations. An update site contains all features for the Developer Studio. You can initiate a check for updates or
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additional features in the Developer Studio and install them when available. The update site capability mirrors the
SAP Developer Studio update site on SAP Service Marketplace for an improved update performance. It does not
run on a multi-node cluster.

The NWDS update site has been replaced by an Eclipse-based solution.
Dependencies

NWDS update site requires Application Server Java as a prerequisite in the same system.
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a
binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does
not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency
(see: http://help.sap.com/disclaimer).
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http://help.sap.com/disclaimer/

go.sap.com/registration/
contact.html

© 2017 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any
form or for any purpose without the express permission of SAP SE
or an SAP affiliate company. The information contained herein may
be changed without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software
vendors. National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company
for informational purposes only, without representation or warranty
of any kind, and SAP or its affiliated companies shall not be liable for
errors or omissions with respect to the materials. The only
warranties for SAP or SAP affiliate company products and services
are those that are set forth in the express warranty statements
accompanying such products and services, if any. Nothing herein
should be construed as constituting an additional warranty.

SAP and other SAP products and services mentioned herein as well
as their respective logos are trademarks or registered trademarks
of SAP SE (or an SAP affiliate company) in Germany and other
countries. All other product and service names mentioned are the
trademarks of their respective companies.

Please see http://www.sap.com/corporate-en/legal/copyright/
index.epx for additional trademark information and notices.

Material Number: 50118213
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